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SOFTWARE PRODUCT:  SpectraPro 

Copyright 1995-2007 (C) VMI AB SWEDEN - All Rights Reserved 
 

 

IMPORTANT READ CAREFULLY: This VMI SOFTWARE LICENSE AGREEMENT (SLA) is a legal agreement 
between you (either an individual or a single entity) and VMI AB SWEDEN for the SpectraPro 
SOFTWARE PRODUCT identified above, which includes computer software and associated media and 
printed materials (if any), and may include online or electronic documentation. By installing, copying, 

transferring or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this 
SLA. If you do not agree to the terms of this Agreement, you are not authorized to use, copy, or 
transfer the SOFTWARE PRODUCT. 
 

1. Grant of License 
a. Evaluation and registration 

The SOFTWARE PRODUCT is not free software.  

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 

otherwise) without prior VMI AB written permission.  
If, after the evaluation period, you decide that the PRODUCT does not fit your requirements, you have 

to uninstall and destroy all Product’s copies.  
 

b. Standard License 
i. Workstation / file server 

Except as set forth below, you may use the SOFTWARE PRODUCT on any single computer. You may 
also install a copy for your exclusive use on either a home or portable computer. 
If you have acquired the PRODUCT in a VMI Software License Pack, you may make the number of 

additional copies of the PRODUCT equal to the number of purchased licenses and you may use each 
copy in the manner specified above. You are also entitled to make a corresponding number of 
secondary copies for either home or portable computer use as specified above. 
 

c. Educational License 
You may use the PRODUCTS acquired in special conditions (usually lower price) as Educational License 
ONLY if you are an educational institute and ONLY on educational purpose computers. You are not 
allowed to use these Licenses for administrative, accounting or other such activities. 

 
d. Open License 

You may use the PRODUCT acquired as Open License on ALL your computers, Internet domains, 

branches that belong to your company, but only in one country. There is NO RESTRICTION to use the 
PRODUCT inside the company (including local branches). 
 

e. Update 
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All licensees may download and use the latest version of the PRODUCT and the latest Service Pack, 

starting with the first installation, but not longer than 14 months from PRODUCT acquisition. 
 

2. Other rights and limitations 
a. Storage 

You may store or install a copy of the PRODUCT on a storage device, such as a network server, used 
only to install or run the Software over an internal network; however, you must acquire and dedicate 
a license for each individual who will use the PRODUCT. One License for the PRODUCT may not be 

shared or used concurrently on different computers. If the Software is installed on a network server or 
other system that physically allows shared access to the Software, you agree to provide technical or 
procedural methods to prevent use of the Software by individuals not specifically licensed to use the 

Software pursuant to this Agreement. 

 
b. Transfer 

You may transfer the Software and Documentation to a single recipient on a permanent basis provided 
you retain no copies of the Software or Documentation (including backup or archival copies) and the 

recipient agrees to the terms and conditions of this Agreement. If the Software is an upgrade, any 
transfer must include all prior versions of the Software and Documentation. 
 

c. Reverse Engineering 

You may not modify, translate, reverse engineer, recompile, disassemble (except to the extent 
applicable laws specifically prohibit such restrictions) or create derivative works based on the 
Software, or any portion thereof. 

 
d. Copying 

You may not copy the Software or Documentation except as specifically provided by this Agreement. 
 

e. Rental 
You may not rent or lease the Software or Documentation. 
 

f. Proprietary Notices 
You may not remove any proprietary notices, labels or marks on the Software or Documentation. 
 

g. Use of VMI’s name 

You may not use VMI or VMI's suppliers' name, logos, or trademarks in any manner including, without 
limitation, in your advertising or marketing materials, except as is necessary to affix the appropriate 
copyright notices as required herein. 
 

3. Termination 
The License is in effect until terminated. The License will terminate automatically if you fail to comply 
with the limitations described herein. On termination, you must destroy all copies of the Software and 

Documentation. 
 

4. Diverse 
This Agreement represents the complete agreement concerning this license between the parties and 

supersedes all prior agreements and representations between them. This Agreement may be amended 
only in writing executed by both parties. THE ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY 
YOU IS EXPRESSLY MADE CONDITIONAL ON YOUR ASSENT TO THE TERMS SET FORTH HEREIN, AND 
NOT THOSE CONTAINED IN YOUR PURCHASE ORDER. If any provision of this Agreement is held to be 

unenforceable for any reason, such provision shall be reformed only to the extent necessary to make 
it enforceable and the remainder of this Agreement shall nonetheless remain in full force and effect 
 

5. Limited warranty 
a. Media 

VMI warrants that the media containing the Software, if provided by VMI, is free from defects in 
material and workmanship and will so remain for 30 (thirty) days from the date you acquired the 

product. VMI's sole liability, and your sole remedy, for any breach of this warranty shall be to replace 

your defective media. Replaced media shall be covered by this limited warranty for the period 
remaining under the warranty that covered the original media, or if longer, for thirty (30) days after 
the date of shipment to you of the replaced media 

 
b. Software Product 

This software and the accompanying files are provided "as is" and without warranties as to 

performance or merchantability or any other warranties whether expressed or implied. Because of the 
various hardware and software environments into which VMI may be put, no warranty of fitness for a 
particular purpose is offered.  
 

Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it. The user must assume the entire risk of using the program 
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The rest of the warranties do NOT refer to evaluation period. 

 
.  VMI warrants that (a) the Software will perform substantially in accordance with the accompanying 
written materials for a period of ninety (90) days from the date of receipt, and (b) any Support 
Services provided by VMI shall be substantially as described in applicable written materials provided to 

you by VMI, and VMI support engineers will make commercially reasonable efforts to solve any 
problem issues. To the extent allowed by applicable law, implied warranties on the Software, if any, 
are limited to 90 (ninety) days. VMI's sole liability, and your sole remedy, for any breach of this 

warranty shall be, in VMI's sole discretion: (i) to replace your defective Software; or (ii) if the above 
remedy is impracticable, to refund the License fee you paid for the Software. Replaced Software and 
Documentation, if any, shall be covered by this limited warranty for the period remaining under the 
warranty that covered the original Software, or if longer, for thirty (30) days after the date of 

shipment to you of the replaced Software. 
Only if you inform VMI of your problem with the Software during the applicable warranty period and 
provide evidence of the date you acquired the Software will VMI be obligated to honor this warranty. 

VMI will use reasonable commercial efforts to replace or refund pursuant to the foregoing warranty 
within thirty (30) days of being so notified. THIS IS A LIMITED WARRANTY AND IT IS THE ONLY 
WARRANTY MADE BY VMI. VMI MAKES NO OTHER WARRANTY, REPRESENTATION, OR CONDITION, 
EXPRESS OR IMPLIED, AND EXPRESSLY DISCLAIMS THE IMPLIED WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NO INFRINGEMENT OF THIRD PARTY 
RIGHTS. THE DURATION OF IMPLIED WARRANTIES OR CONDITIONS, INCLUDING WITHOUT 
LIMITATION, WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND OF FITNESS FOR A 

PARTICULAR PURPOSE, IS LIMITED TO THE ABOVE LIMITED WARRANTY PERIOD; SOME 

JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY OR 
CONDITION LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU. NO VMI AGENT, OR EMPLOYEE IS 
AUTHORIZED TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY. If 
you make any modifications to the Software during the warranty period; if the media is subjected to 

accident, abuse, or improper use; or if you violate the terms of this Agreement, then this warranty 
shall immediately be terminated. This warranty shall not apply if the Software is used on or in 
conjunction with hardware or software other than the unmodified version of hardware and software 

with which the Software was designed to be used as described in the Documentation. 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS 
THAT VARY FROM STATE TO STATE OR BY JURISDICTION 
 

6. Limitation of liability 
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE, 
SHALL VMI OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY 

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE 
OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES, OR FOR ANY 
DAMAGES IN EXCESS OF VMI'S LIST PRICE FOR A LICENSE TO THE SOFTWARE AND 

DOCUMENTATION, EVEN IF VMI SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 
 

7. Copyright 

All intellectual rights in the Software and Documentation are property of VMI. By buying or using the 
software you are granted only an non-exclusive right to use a copy of the software. All intellectual 
rights in the Software remain property of VMI. Sweden copyrights law and international treaties 

protect the PRODUCT. 
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I. Installing the software 

This product has been developed to work on any properly configured version of 

Microsoft® Windows® XP, 2000, 2003, 98, ME, NT4 or VISTA operating systems 

or higher. 

 

Due to the nature of the anti-piracy security technology built into this product, 

using illegal keys may lead to software failure or instability. 
 

 

Before you run the setup file make sure that you close all other programs. This 

includes anti-virus software and any other programs that are running. If you do 

not follow this procedure it may interfere with the normal setup procedure. 
 

From CD-ROM: 

To start installing the software onto your computer you have to make sure that 

the CD-ROM is put into the CD-ROM player. Because of the 'Autorun' 

functionality, the installation program will start automatically. When this does not 

happen, go to 'My Computer' and double click the CD-ROM icon. Next: double 

click on the installer and follow the instruction displayed on screen. 

 

 

 

Press SpectraPro label and follow the instruction displayed on screen. 

If you accept the default location, SpectraPro will be installed on C:\Program 

Files\SpectraPro directory. 
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As Download: 

When you have obtained the software as a digital file, e.g. downloaded it, there 

are two possible variants. A) You have a zipped file (.zip file) or B) you have the 

installer (.exe file). 

When you have a zipped or stuffed file (recognizable by the compression icon) 

you need to have ‘WinZip’ or a different program that supports these compressed 

files. 

If you have the Installer file you can proceed by double clicking this file. The 

installation will start and you will have to follow the instructions displayed on 

screen. 

 

I.1. Installing the latest Service Pack 

The latest available Service Pack is always onto the CD-ROM. 

Before to run the Service Pack Installation file, first start the SpectraPro once. 

With this occasion you can select the software language also. 

 

 

 

I.2. Updating the software 

SpectraPro software is equipped with an automatic software update check. 

You can easily check if there is a free update available by selecting Help > Check 

for Updates from the menu bar. 

An Internet connection is needed for this. 

 

 

 

 

 

I.3. Installing MSDE Database Server (optionally) 

MSDE is an SQL Server database server with the following differences: 

1. Maximum size of the database is restricted to 2 GB. 

2. MSDE server can be used in a network with maximum 5 users only. 

MSDE is free and can be installed in any workstation. 

From the installation page press MSDE button. 
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NOTE: MSDE is not suitable for VISTA operation system! 

If your computer runs VISTA, please install instead SQL Server Express 

Edition with SP2. 

 

 Bellow is the welcome screen for MSDE installation: 

 

 

 

 

 

 

 

Press NEXT and follow on screen instruction. 

After the installation will be completed, in the computer task bar a small icon will 
indicate that the MSDE Server is running: 

  

 

 

I.4. Installing protection key drivers 

Where are two type of protection key: parallel and USB. 

 

HASP USB protection key 

 

Parallel HASP protection key not need any driver. For USB protection key you 

may need to install drivers. Normally, the drivers are installed together with the 
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SpectraPro application, but sometime, especially under VISTA, the drivers can’t 

be installed automatically. 

Before to start SpectraPro for the first time you can check if the USB protection 

key drivers are installed properly or not, running the external software: 

Start > Programs > SpectraPro > Protection key test. 

 

 

 

 

 

 

 

 

Be sure that the protection key is inserted in any USB hub and press Test Key 

button. If the protection key drivers are installed properly, the key type will be 
shown. Otherwise an error message will be displayed. 

If this is the case, run Start > Programs > SpectraPro > Install HASP Drivers.  

If still you have some problems with the HASP protection key, please visit: 

http://www.aladdin.com. 

 

I.5. Installing SQL Server Express (optionally) 

SpectraPro application running under Vista Operating System can create 

machine databases also in a SQL Server Express database Server, installed on 

the local computer. 

For details regarding how to install SQL Server Express on your computer and 

also License details visit: 

http://msdn2.microsoft.com/en-us/express/bb410792.aspx 

 

Before you complete a Microsoft SQL Server download and install any member of 

the SQL Server 2005 Express Edition family, you must install first .NET 

Framework 2.0: 

http://www.microsoft.com/downloads/details.aspx?familyid=9655156b-356b-

4a2c-857c-e62f50ae9a55&displaylang=en 

Microsoft SQL Server 2005 Express Edition is the free, easy-to-use, lightweight 

version of SQL Server 2005.  
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The best choice is to download SQL Server 2005 Express Edition SP2. 

After software download, install the SQL 2005 Express following the instruction 
bellow. 

Locate and run the SQL Server Express installation file SQLEXPR32.exe. 

Follow on-screen instruction. Generally, press NEXT on each step. 

During installation some settings are required, as follow: 

 

When the bellow windows appear, select Mixed Mode and just press Next. 

 

In the following windows, select Enable User Interface and press Next. 
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Complete the installation. 

I.6. Using the help, menu and toolbars 

If you experience any problems when using the software you can open the help 

file by clicking Help from the Toolbar or pressing F1. It provides basic information 

on how to use the software with both a step-by-step guide and a more detailed 

description of all the available functions. 

 

The functionality of the software can be accessed from different locations. The 

main menu, of course, gives access to all the functions within the program, and 

the Toolbar provides the most commonly used functions. The Status bar, at the 

bottom of the program window, displays information about the opened database. 

 

I.7. Trademarks 

Microsoft
® 

and Windows
® 

are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.  

Oracle
®

 is a registered trademark of Oracle Corporation and/or its affiliates. 

HyperTerminal is a trademark of Hilgraeve Inc.  

All other brand or product names are trademarks or registered trademarks of 

their respective companies or organizations.  
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1. SpectraPro©©©© architecture 

SpectraPro can work in conjunction with the following machine database types: 

• MS Access  

• MSDE (Microsoft
®

 Database Engine) – not suitable for Windows
®

 VISTA 

• Microsoft
®

 SQL Server 2005 Express Edition SP2  

• Microsoft
®

 SQL Server  

• Oracle
®

 8.0 (or newer)  

All of these have Client-Server architecture. 

MSDE and SQL Server are very similar; in fact MSDE is an SQL Server server with 
the following differences: 

3. Maximum size of the database is restricted to 2 GB. 

4. MSDE server can be used in a network with 5 users only. 

SpectraPro can create and manage also MS Access database type. The MS Access 

isn't a real database server, but has a database structure. A MS Access databases 

have the following advantages: 

1. Small space required on the hard disk and low resources required from the 
host computer. 

2. Easily transferred to other computers. 

3. Easily to create backup file. Just copy the database file (with extension .sp3) 

onto a USB stick or somewhere in a network computer. 

In the same time the MS Access database have also the following disadvantages: 

1. Is not a safe database, especially for a large number of machines 

2. Used in a network, this type of database will dramatically increase the 

network traffic and slow-down the communication speed. 

3. It is not a solution for large enterprise integration. 

For these reasons it is not recommended to use the MS Access database for 
company applications. 

 

1.1. Client/Server Architecture 

  

A Database Server is designed to work effectively in a number of environments:  

• As a two-tier client/server database system  

• As a desktop database system  

1.1.1. Client/Server Database Systems 

Client/server systems are constructed so that the database can reside on a 

central computer, known as a server and are shared among several users. Users 

access the server through the SpectraPro application.  

Having data stored and managed in a central location offers several advantages:  
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• Each data item is stored in a central location where all users can work with it.  

Separate copies of the item are not stored on each client, which eliminates 

problems with users having to ensure they are all working with the same 

information.  

• Security rules can be defined one time on the server and enforced equally 
among all users.  

• A relational database server optimizes network traffic by returning only the 
data an application needs.  

  

For example, if an application working with a file server needs to display a list of 

the names and machine descriptions, it must retrieve the entire Machine file. If 

the application is working with a relational database server, it sends this 

command:  

SELECT Name, Description  

FROM Machine  

WHERE MachineID = 123  

The relational database sends back only the names and description of the 
selected machine, not all the information about all machines.  

• Hardware costs can be minimized.  

Because the data is not stored on each client, clients do not have to dedicate disk 

space to store data. The clients also do not need the processing capacity to 

manage data locally, and the server does not need to dedicate processing power 
to displaying data.  

The server can be configured to optimize the disk I/O capacities needed to 

retrieve data, and clients can be configured to optimize the formatting and 
displaying of data retrieved from the server.  

The server can be stored in a relatively secure location and equipped with devices 

such as an Un-interruptible Power Supply (UPS) which is more economical than 
fully protecting each client.  

• Maintenance tasks such as back-up and restoring data are simplified because 

they can focus on the central server.  

In large client/server systems, many users may be connected to a Server 
installation at the same time.  

The Server has full protection for these environments, with safeguards that 

prevent problems such as having multiple users trying to update the same piece 

of data at the same time.  

The Server also allocates the available resources effectively, such as memory, 
network bandwidth, and disk I/O, among the multiple users. 

Server applications can run on the same computer as Server. The application 

connects to the Server using Windows Inter-process Communications (IPC) 

components, such as shared memory, instead of a network. This allows the 

Server to be used on a small system where an application needs to store its data 
locally. 
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1.1.2. Desktop Database Systems 

While Database Server works effectively as a server, it can also be used in 

applications that need stand-alone databases stored locally on the client. The 

Server can configure itself dynamically to run efficiently with the resources 

available on a client, without the need to dedicate a database administrator to 

each client. SpectraPro can also embed a MSDE Server as the data storage 

component for machine databases. 

When clients use local Database Server, one copy of the Database Server 

engine runs on the client and manages all the databases. SpectraPro connects to 

the database engine in much the same way they connect across the network to a 
database engine running on a remote server. 
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2. Database architecture 

 

The Database Server data is stored in databases. The data in a database is 

organized into the logical components visible to users. A database is also 

physically implemented as two or more files on disk, depending on the Server 

type. 

When using a database, you work primarily with the logical components such as 

tables, views, procedures, and users. The physical implementation of files is 

largely transparent. Typically, only the database administrator needs to work with 

the physical implementation.  

Each Database Server installation has multiple databases. Some organizations 

have only one user database, containing all the data for their organization. Some 

organizations have different databases for each group in their organization, and 
sometimes a database used by a single application, like SpectraPro. 

For example, an organization could have one database for sales, one for payroll, 

one for a document management application, one for rotating machinery and so 

on. Sometimes an application uses only one database; other applications may 
access several databases. 

It is not necessary to run multiple copies of Database Server to allow multiple 

users to access the databases on a server. Database Server is capable of 

handling thousands of users working in multiple databases on the same server at 

the same time. Database Server makes all databases on the server available to 
all users that connect to the server, subject to the defined security permissions. 

When connecting to Database Server, your connection is associated with a 

particular database on the server. This database is called the current database. 

You are usually connected to a database defined as your default database by the 

system administrator, although you can use other connection options in the 

SpectraPro to specify another database. You can switch from one database to 
another with the Change command from SpectraPro application. 

The SpectraPro allows you to create multiple machine databases, in the local 

Database Server (MSDE or SQL Server 2005 Express Edition SP2) or in a remote 

server (SQL Server or Oracle). Using the Database > Exchange Machine 
command you can copy machines from one Database Server to another. 

 



SpectraPro
©©©©
 User Manual 

 

 
12 

 

 

 

 
 

 
3. SpectraPro Overview 

 
SpectraPro software is mainly dedicated to implement a true Proactive 

Maintenance Program. 

 

For every plant, you can create a database, which can have an unlimited number 

of machines, points and directions. The spectra are stored at the level of the 

measurement directions. If for a direction you store more then two spectra, then 

you can display a trend of the evolution in time of the Total Vibration or trend of 

the evolution in time for Bearing Condition Coefficient (BC). If Envelope 

measurement is done, also Envelope spectra are available for trending.  

On the Machine level, Manual Entry point can be added. The Manual Entry points 

are not measured point, but values entered directly using the keyboard. 

For X-Viber Instrument also Temperature and Speed points can be defined in the 

database. 

   

Default, only the last 24 measurements are shown for that direction, but you can 

change this number using Settings > Optional settings command.  

 

The program allows to copy, in clipboard, any displayed graph (spectra or trend) 

and later to copy this graphs in a text editor (e.g. WORD) or in the Notepad. 

Customized professional reports about the machines can be made in this way. 

 

The machine Database store machinery measurement, unloaded from the 

EasyBalancer, EasyViber or X-Viber instruments. 

 

The users can add, in the Notepad, information following the diagnosis procedure. 

Trough Database > Import command, external useful data can be added to the 

databases, regarding repair process, spare parts used, etc. This information can 

come directly from CMMS or prepared, in a special format by the maintenance 

teams. 

 

In this way valuable, complete information can be added, in time, for each 

machine from the databases. 

 

Analysing this information, periodically, you can act proactively, discovering the 

real causes of the failures. 

 

Main purposes of using this software is to supply to the maintenance team a 

periodical report regarding the action to taken to maintain the machinery in good 

working condition. For this reason, SpectraPro can create a Job report. 

 

In order to analyze the collected data you have on your choice many ways of 

viewing data: 

• A collection of trends and spectrum selected by you (View > Show selected 

information). 

• A Quick View session, in which you explore the machines, the trends and 

spectra associated with the selected direction (View > Quick View). If Bands are 

defined, also Band Trends are available. 
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• Trends and spectra from whole machine in which you can see at once, all 

this trends and spectra associated with the selected machine (View > Show 

spectra from whole machine). 

• A List View in which you can see at once, all Total values (Vibration, Bearing 

Condition and Envelope) for the whole machine (View > List View). Also the 

Alarm status is indicating. 

• A Band View in which you can see, at point level, all vibration total values 

and Band values (peak average for the band width). Alarm status for above is 

also indicated (View > Band View). 

• Graph View is a specially mode of displaying the data. A GraphView 

protection key is required. The GraphView project can be customised using the 

external software provided in the SpectraPro Installation kit: 

Start > Programs > SpectraPro >GraphView Editor.  

 

In all these views, a Notepad is available on the machine level, to type all the 

observations in time of diagnosis process. 

 

Finally, chose the Report > Job Report command and you can customise a report 

for the maintenance teams, using all the notes supplied. Once you customise a 

Job Report, the appearance of this will be saved, and next time the report can be 

create in a very short time. 

 

Job Report can be transferred to a text editor. You can then preview, modify and 

finally print the Job Report. You can also preview and print directly the report to 

the system printer. 

 

From time to time you will want to make a report regarding all the history of a 

selected machine. 

 

Use Report > Machine History command to do this. 

  

You can also customise the History report and then preview, modify and print it. 

 

The previously mentioned reports have to distinct purpose: 

 

• The Job Report is addressed mainly to the maintenance team. 

• The Machine History is useful to take some proactive actions, before a 

failure of the machinery to occur.   

                                                                                                                                                

The SpectraPro software is very flexible software and offers to you many 

commands to do same action in different way. Before to use the software, read 

carefully this document and using DemoPro databases provided in installation 

kit, try to learn how to use efficient this powerful program. 

 

If you run this software for the first time, then you can use DemoPro databases 

which are included in the installation kit. In this way, you can learn how to work 

with the software and to evaluate the special performance of it. 

 

On the screen, a list of Menus and a Toolbar are displayed. In the Status Bar, 

on the bottom of the screen, the active database is also displayed. On the first 

run, the active database is DemoPro. Although you can create, you're own 

database, on the beginning, use DemoPro database to display spectra and 

trends. 
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If you run the program for the first time, select Settings > Optional Settings 

command. Select the units (metric or imperial) and the measurement unit for 

frequency (Hz or CPM). For the moment, don’t change the number of spectra in 

trends. You can do this later. Click Save to save this setting. 

 

Choose from the View menu, Show Selected information command. A specific 

window will appear in the screen, which will allow you to choose the department, 

the machine, the point and the wished direction. Choosing is done selecting a 

certain direction, with the mouse, in the above-mentioned order. When the 

direction is selected, in the upper right side it appears a list with all collected 

measurements for that direction. Coloured small icons indicate also an alarm 

condition for the measurements. A check mark icon indicates the base line 

spectrum, if set. Now you can select a collection of trends and spectra to be 

shown. Just double – click to any trend or direction and the item will be move to 

the show list. 

 

Instead of double – clicking, you can drag and drop any Direction or Spectrum to 

the show list. 

If you want to not display some items from the show list, just double – click on 

that items and item will be remove from the list. 

 

Finally, press Show button, and the entire list will be shown. 

 

After you displayed some trends and spectra – set, the main window remain 

active and you can select other trends or spectra. Although it can display a large 

number of information’s on a single screen, it is recommended to limit the 

number of simultaneously opened plots, because the plots will have smaller and 

smaller sizes and many details will be lost. 

 

For details regarding an efficient way of using the spectrum and trends plot, see 

also: 

• Spectrum plot 

• Trend plot 

• Time-signal plot 

• Coast-down/Coast-up plot 

 

Other ways for displaying data are: 

• Quick view 

• Show Spectra from whole machine 

• List View 

• Band View. 

Try also these commands to see the differences, but first read the help associated 

with commands. 
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4. Creating, registering and editing databases 
 

 

To make a functional program, every user has to create an edit its own database. 

For each part of a whole plant, it is recommended to create a separate database. 

 

4.1. Create a new database 

 

To create a new database use Database >Create command. 

 

First select a database server where the database will be created: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
You can create machine database in the following database servers: 

• MS Access  

• MSDE (Microsoft
®

 Database Engine) – not suitable for Windows
®

 VISTA 

• Microsoft
®

 SQL Server 2005 Express Edition SP2  

• Microsoft
®

 SQL Server  

• Oracle
®

 8.0 (or newer)  

 

4.1.1. Creating a MS Access machine database. 

  
First select the Server type to be MS Access. You not need any Administrator 

ID or password. Press NEXT. 
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The SpectraPro name is optionally. If you don’t type any name, the SpectraPro 

name will be the database file name. 

 

Press NEXT to continue. 

 

A new MS Access database with the name MyDataBase.sp3 will be created in the 

C:\SpectraPro\Data directory. 

 

 

NOTE: To create a backup copy of your database, simply copy the .sp3 file 

in a safe location. 

 

 

4.1.2. Creating machine database in MSDE Server. 

 

First select the Server type to be (Local). You not need any Administrator ID or 

password. Press NEXT. 
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The SpectraPro name is optionally. If you don’t type any name, the SpectraPro 

name will be the database file name. 

 

Press NEXT to continue. 

 

A new database with the name MyNewBase will be created in the 

C:\SpectraPro\Data directory. 

A MSDE database has several files, as follow: 
MyNewBase_table.sp7 

MyNewBase_index.sp7 

MyNewBase_image.sp7 

MyNewBase_log.sp7 

 

 

NOTE: You can’t make a backup of the database copying the above files! 

Please contact your IT Department to make periodic backup copy of your 

databases. Alternatively, use external software DBManager.exe. 

 

 

4.1.3. Creating machine database in a SQL Server Express Database 

Server 

 
 

SpectraPro application running under Vista Operating System can create 

machine databases also in a SQL Server Express database Server, installed on 

the local computer. 

If you are a normal user, you will be not able to create SpectraPro database 

because you don’t have enough rights to do this. 

 

Bellow is explained, step-by-step, how you must configure the VISTA Operation 

System to allow a normal user to create SpectraPro database in a specific folder 

(directory). 

  

Locate the Data folder (in a default SpectraPro installation is C:\Program 

Files\SpectraPro\Data). 

Alternatively, you may create a new database folder. 

Click right-mouse on the folder name and select Properties. 

 

In the bellow windows, select Security tab. 

From Group or user names select Users (VISTA-PC\Users) where VISTA-PC 

is your computer name. 
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Press Edit button. 
The following windows will appear. 
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From Group or user names select again Users (VISTA-PC\Users). 

In the Permission for Users area, click on Full control check box in the Allow 

column. 

Also the Modify item must be checked. 

Press Apply button. 

Press OK button to return. 

 

Now the initial windows will look as follow: 
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You can observe that for the Users, the Full control and also Modify items are 

checked. 

Press OK to exit. 

Now the SpectraPro will have permission to create new database, but only in the 

Data folder. 

You can create more than a single folder to store SpectraPro databases using the 

SQL Server Express.  

 

Before to create a new database, be sure that the SQL Server Express is installed 

on your computer. 

 

To test the connection with your SQL Server Express, proceed as follow: 

 

In the Start > Control Panel >Administrative Tools > DataSources (ODBC) select 

UserDSN tab and press Add. 
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From the list select SQL Server and press Finish button 
 

 

In the Create a New Data Source to SQL Server windows type a name in the 

Name text box. 

 

In the Server combo box, select VISTA-PC\SQLEXPRESS item, where VISTA-
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PC is your computer name. 

 

 

Press Finish button. 

 

Now you can test the connection with the database Server: 

 

Press Test Data Source button. 
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If the connection is successfully established, the following message will appear: 

 

Now you are ready to create your own databases. 
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OPTION 1 

Select Server type to be (Local) and follow instruction on-screen. 

 

OPTION 2 

Select Server type to be SQL Server. 

 

 

 

Type the Server Name. In above example the server name is VISTA-

PC\SQLEXPRESS. 

You must replace the VISTA-PC with your computer name. 

Type the Administrator ID and Password. In a default installation of the SQL 

Server Express, the Administrator ID is “sa” and is no password. 

 

Press NEXT button to continue. 

 

In the next windows type a name for your database and type the location  
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Press NEXT twice to continue. 

The database will be creating in the named folder. 

 

4.1.4. Creating a SQL Server machine database. 

 
Before to create a database in a remote SQL Server, be sure that your computer 

is connected with the computer where SQL Server is installed.  

SpectraPro can create database in any SQL Server, after SQL Server 7. 

  
First select the Server type to be SQL Server. You may need Administrator ID 

and a valid password. Ask for help if is required. 
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If the Administrator ID and the password are correct the new database will be 

create. Otherwise, an error message will be shown. 

 

A SQL Server database has several files, as follow: 
MyBase_table.sp7 

MyBase_index.sp7 

MyBase_image.sp7 

MyBase_log.sp7 
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NOTE: You can’t make a backup of the database copying the above files! 

Please contact your IT Department to make periodic backup copy of your 

databases. This action must be done regularly in the Server computer. 

 

 

 

4.1.5. Creating an Oracle machine database. 

 

Before to create an Oracle database please check: 

- If an Oracle database server exist and run in your network; 

- If a Service to connect your computer with Oracle database server exists in your 

computer. 

 

For more details please contact your IT Department. 

 

First select the Server type to be Oracle. 
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Now type the database file name. 

 
 

In Oracle database server, the database name is the UserID name. 

If the connection with your Oracle database server is OK, the new database will 

be create. 

 

4.2. Database registration 

 

Before to use any SpectraPro database, you must register it.  

 

Use Database > Registration command to add an existing database to your 

registration list. 
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If you create you’re own database, the database will be self-registered. To have 

access to the other SpectraPro database from the network, you must register 

them first. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Click to Add button and select a valid SpectraPro database. 

 
 

In above example a remote SQL Server database is selected. 

You can add any type of SpectraPro database. 

Only registered databases can be activated in the SpectraPro software. 

If the SpectraPro is installed in a network, each user can have his own database 

collection. 
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The databases will be added in the registered list of databases. You can any time 

Remove a egistered database. This not means that you delete the selected 

database, just remove it from the list. In addition, you can rename the “generic” 

name of the database. 

Finally, click Cancel to terminate the command. 

 
4.3. Database change 

 
SpectraPro can manage many databases, but not in same time. This means that 

you must make a particularly database (from the registered database list) active. 

Use Database > Change command to do this: 

 
Double-click on the item in the list or select with a click the database, and after 

press Change button. To conclude, press OK button. The name of the file 

selected will appear in the status bar. 

 

 

 

4.4. Database Edit 

 
Use Database > Edit command to edit a database. To do this, select this 

command from the main menu or press the dedicated button from the toolbar: 

 

 

 

This command is used to edit the active database (add, delete, rename items) 

and for database maintenance. 

In accordance with the selected item from the hierarchy tree, you can add 

machine, point or direction. 

 

4.4.1. Database Level 

 

On the Database level you only can add Departments (or plants): 
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4.4.2. Departments Level 

 
On the Departments level you can add Machines and also you can delete or 

rename Departments: 

 

 
4.4.3. Machine Level 

 
On the Machine level you can add Points. You can delete or rename the selected 

Machine. Also you can view the structure of the database: 

 

 
 

The following point’s type can be 

added: 

-Vibration point 

-Temperature point (only for 

XVIBER) 

- Speed point (only for XVIBER) 

- Manual entry point 

 

Only vibration points has 

Directions.  

 

 

 

4.4.4. Point Level 

 

On the Point level you can add a Direction. You can delete or rename the selected 

Direction. Also you can view the structure of the database: 
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4.4.5. Direction Level 

 

 

On the Directions level you can delete or rename selected Direction. Also you can 

view the Trend plot (if any): 

 

After adding a new item in the database, any selected item can be renamed. The 

new items are added with a default name, which can be changed any time. To do 

these, select the item of which wants to change and press Rename button. Then 

change the name using the keyboard and finish with OK. An empty name is not 

allowed. 

 

For deleting an item, select the item and press Delete button. 

 

If the item is not the last one in the hierarchy tree or in that particular direction is 

already stored measurements then the item can′t be deleted. As a general rule of 

deleting is one that a deleting procedure must be made in the following order: 

• measurement 

• direction 

• point 

• machine 

• plant (department) 

 
The spectra deletion can be done by selecting one or more spectra and then 

pressing the Delete button or keyboard Delete key. 
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The baseline spectrum can’t be deleted. First double-click on item to transform 

baseline spectrum in normal spectrum and after that you can delete it. 

After you finish machine definition (plant, machine, point and direction) on each 

level of the hierarchy you can edit fault frequencies, very helpful later. 

 

 

 
4.4.6. Editing on machine level 

 

On machine level you can edit: 

 
- A short description - a 30 – 40 char length, description of the machine. This 

description can be use in reports. 

- A machine description - clicking on Description button a text editor appear. 

For each machine you can fill here as much information you want. You can use 

different type of colour, letter size and alignment. You can import the contents of 

some external file (text or RTF file) or picture. The contents of machine 

description can be printing with Report > Machine Description Report. 

 
- Machine picture. For each machine you can add a picture from the existing 

collection provided in the installation kit. The picture must be in a picture file 

format. Of course, you can make your own picture with a digital camera. To add a 

picture to a machine click Browse button and select any picture file. 

 

 

 

- Reference speed. For each machine you can define 2 reference rotational speeds. 

First is primary rotational speed, and other one in the secondary reference speed, 

related with first one. These speeds will be useful later, on shaft speed definition 

for each point. In this respect you can label these two speeds for easiest 

recognition in future. 
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For variable speed machine define the primary rotational speed to be zero. 

The software will determine the real shaft speed using the latest 

measurement. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
For more details see Speeds setting 

 
- Electrical motor fault frequencies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can define the followings fault frequencies: 

- Line frequency (LF) 

- Pole pass frequency (PP) 

- Rotor bar pass frequency (RBP) 
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- Belt fault frequencies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Multiply fault frequencies. 

  You can define five multiply fault frequencies for each machine: 
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4.4.7. Editing on point level 

 

On point level you can select or define a bearing, and a shaft speed. The shaft 

speed can be one previously defined or other related with main reference speed 

or secondary reference speed. 

 

Also you can edit the specific data for a gearbox. 

To select a bearing push Bearing button and after that press Library button.  

 
On each point you can add up to 4 bearings: 

 
If Library button is selected, the Bearing Library window will appear. 

In the library exist more than 6000 bearing definitions. The user can also add 

some new bearing definitions in the Bearing Library Database. 
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The bearing library window appears as follow: 

 

 

 

 

To add a new bearing in the Library, proceed as follow: 

- Press New to add a new Manufacturer in the list 

- Press New to add a new bearing 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you know the fault coefficients, select option Edit frequency data. 

If you know only the bearing dimensions, select option Edit dimensions. 

Finally, press OK to save the bearing definition. 

 

 

4.4.8. Automatic adjustment of the pre-calculated bearing fault 

frequencies. 

 

The bearing fault frequency can be displayed in any spectra plot. 
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A typical spectrum from a bearing with faults is shown above. In most cases the 

calculated and the measured frequencies will be separated with a small margin. 

 

In the SpectraPro software is implemented a function where the basic fault 

frequency lines with multiples are moved to the nearest peak if some exist within 

the selected gap. If in this interval more than one peak exists, the fault frequency 

line will be moved to the highest peak found. 

 

If the basic fault frequency is moved, also the side bands will move with the same 

distance. Because the distance between the measured and the calculated 

frequency can vary slightly from multiple to multiple this adjustment is done on 

each basic bearing fault frequency separately. 

 

 

4.4.9. Editing gear box fault frequency 

 

To define the fault frequencies for 

a gear box proceed as follow: 

 

Press Gear button. The following 

window will appear: 

 

 

 
 

Before to set the gear 

frequencies, set for each point of 

the machine the proper calculate 

speed.  

For the selected point, type the 

number of the gear teeth and 

select the conjugate point. If the 

conjugate point was correctly 

selected, the number of conjugate 
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gear teeth will be an integer and the OK button will be activate. Otherwise you 

can not save the settings. 

Before to save the setting, type a label name for the gear mesh frequency. 

To understand better the gear box settings please analyze the following example. 

 

 

 

The gear box has the following characteristics: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type: FLENDER Model KZN 280 

Z1=16 teeth 

Z2=26 teeth 

Z3=17 teeth 

Z4=47 teeth 

Z5=14 teeth 

Z6=45 teeth 

 

On machine level set the main reference speed to 3000 RPM and label it as 

“MotorSpeed”. 

Set the secondary reference speed to the output shaft (P4): 207.7467 RPM with 

the label “RollSpeed” 

For the input shaft (P3) set the shaft speed to be 1XMotorSpeed  

For the Intermediate1 shaft set the speed to 0.61538XMotorSpeed=1846.1538 

RPM 

For the Intermediate2 shaft set the speed to 0.22258XMotorSpeed=667.75 RPM 

For the output shaft (P4) set the speed to 1XRollSpeed=207.7467 RPM 

Press Gear button for the point P3 and make the settings: 

Number of teeth to 16 and label “GM1/2”. Select the conjugate point to be 

Intermediate1 (26 teeth for conjugate point will appear). 

Press Gear button for the point Intermediate1 and make the settings: 

Number of teeth to 17 and label “GM3/4”. Select the conjugate point to be 

Intermediate2 (47 teeth for conjugate point will appear). 

 

Press Gear button for the point Intermediate2: 

Number of teeth to 14 and label “GM5/6”. Select the conjugate point to be point 

P4 (45 teeth for conjugate point will appear). 

Press Gear button for the point P4: 

Number of teeth to 45 and label “GM5/6”. Select the conjugate point to be point 
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P4 (14 teeth for conjugate point will appear). 

 

Now the setting is complete. 

 

4.4.10. Editing on direction level 

 

On the direction level you can edit the alarm limit for total vibration values of 

the measurements and also to define the Route settings. 

 
Click Alarm settings button and you can edit two alarm levels for each overall 

vibration, BC and Envelope values. Two tables, ISO 2372 diagram and Bearing 

Condition Coefficient diagram is on your disposition to select proper value for 

alarms. Select the unit for total vibration values and also the average type. 

 
Note: If on directions Level is already stored some measurements, you can 

declare, for each direction, one of them to be Baseline. To do this, just double-

click on that measurement. Only one measurement can be Baseline. All other 

measurements are considered to be Normal measurements. 

 
 

 

Click Route settings to set some parameters for route measurements: 

 

 
In the Route settings you can 

select the followings: 

- Maximum spectrum 

frequency 

- Number of sample n time of 

data collection (normally 2 or 

4). 

- Transducer selection (only for 

Easy Viber Data Collector).  

- Collect BC or/and Time signal 

together with the spectrum. 

- Envelope collection. 

- Envelope band pass filter  

- Number of sample for 

Envelope collection. 

 

Finally, Press SAVE button. 

 

You can copy the settings and 

paste to any other direction or to 

ALL direction of the machine. 
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4.4.11. Editing machine in batch 

 

If in your database is more then one identical machine, edit only one machine 

and after that you can copy and paste this machine many times. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Before to copy, the new machine must exist (only as name, the machine 

hierarchy can be empty) 

 

You can save a just created machine in a template database, or use the 

template database to copy a pre-defined machine in your database. 

When the SpectraPro start for the first time, a file with the name: Template.tp7 is 

created as default. The template file is empty. In this file you can add as many 

machines you want. From the template file you can export some machine 

template in other template files. Or from any template file you can import in your 

template file a series of machines. 

 

 
In above window you can: 

- Rename the machine (name, description and machine picture) 

- Remove the machine from the Template file 

- Export the machine in another Template file (the file can be created if 

don’t exist) 

- Import a machine form any Template file (the file must exist) 
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5. Off-route transfer 

 

From Easy Balancer or Easy Viber Analyzers you can transfer the following 

type of off-route data: 

- Spectral data (including time-signal) 

- Envelope spectra 

- Coast –down/Coast-up plots 

- Balancing data 

 
Data can be transferred from these Instruments in two ways: 

� Direct. If the machine database is available you can transfer each file from 
Analyzer in the proper location. 

� Indirect. In this case the data will be transferred first in a Transfer file and 

after that, from the file in the machine database. 

 
5.1. Direct transfer 

 

Direct transfer can be done using the Transfer > Off- route command or pressing 

the specific button from the toolbar. Before to execute this command check: 

� If the serial cable is properly connect on both Analyzer and computer 

ports. 

� If the Analyzer is switched on and on the Analyzer screen the 

Communication menu item is selected. 

 
On the screen the transfer window will appear: 

 
 
In the Status bar the "Awaiting connection" message will appear. 
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Select the proper serial communication port (e.g. COM4), and the data type, 

on your choice (e.g. Spectrum data). 

Now you must select from the Analyzer menu the Print-out/Communication 

command and press "Enter" key. 

 

Depending on your selection in the directory area a list of existing file in 

Analyzer will appear: 

 

  
The Status bar will display “Ready to transfer" message. 

For both Spectra and Coast-down data two type of files can be shown: 

� Single data files ( e.g. 1/1) 

� Double data files. These files are displayed as two items (e.g. 1/2 and 

2/2), having same name and same date (1 sec. more for the second file). 

 

Each item has a specific icon: 

 
 Single spectrum file 
 

              First spectrum from a double spectra file 

 
 Second spectrum from a double spectra file 

 
       Single Coast-down plot 
        
        First Coast-down plot from a double plot file 
 
        Second Coast-down plot from a double plot file 

 

               A "X" mark indicate that this file is already transferred in the machine 

         
       

 
You can not transfer a file with a"X" mark again. 

To do the transfer first selects a file from the list and after that a destination in 

the machine tree. The destination must be a Direction for spectra and Coast-

down data and a Machine for balancing data. 

 

Once the source and destination is properly selected the Transfer button will be 

enabled. 

 
Now you can transfer the selected data in two ways: 
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Press the Transfer button: 

 

Alternatively, drag the selected item and drop to the proper destination. 

 

If you check the "Automatic delete" check box, after transferring is done the 

file will be delete from the Analyzer memory. Here is an exception: if the file 

is double type, the file will be deleted only if both data is transferred. 

 

In same session you can transfer all type of data (spectra, coast-down plots 

and balancing data). 

 

If the "Automatic report" check box is selected, when you press the 

Terminate button, a report will be generating also. 

 
If “Update Alarm” check box is checked, when you press Terminate button, 

the alarms will be update. 

 
 

5.2. Indirect transfer 

 
The indirect transfer must be done in two steps: 

� First, using the external program "Easy Balancer transfer to file", you must 

transfer the data from EB or EV in a Transfer file. The Transfer file has the 

.tr3 extension. 

� Use the Transfer > From file command to transfer the data from the 

selected transfer file in the machine database. 

 
5.2.1. Easy Balancer transfer to file program 

 

Start the program from the Windows > Start > Programs Menu list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Before to execute this command check: 

� If the serial cable is properly connect on both EB and computer ports. 

Press here to create or to 

select a Transfer file 
Press here to select a 
proper COM port 

Select the 
data type 

File grid area 

Directory list 
area 

Status bar for 
message 
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� If  the EB is switched on and on the EB screen the main menu is displayed 

 

Select an existing Transfer file or create a new one. The default extension for 

Transfer files is .tr3. In same file you can transfer data from Easy Balancer or 

Easy Viber analyzer. 

 

Select a proper serial communication port (e.g. COM2). 

Select the data type (e.g. Spectrum data). 

From the EB/EV menu select "Print-out/communication" menu line and press 

"Enter". 

The Status bar message will be "Ready to transfer". 

 

A directory list will appear also. Select any file from this list and press the 

Transfer button. 

 
The selected file will be transferred in the .tr2 file and will appear also in he grid 

list. 

In the Destination field the name of EB file will appear. 

 
Type the final destination in the Destination field of the grid list. You can type the 

whole tree or only Point and Direction.  

 

 

 

 

 

 
After transferring you can press the Recycle Bin button to delete the file 

from the EB instrument. 

 

Select any record from the grid list and press the Show button if you 

want to see a plot of the selected item. 

 

 

Finally press Exit button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type here the 
destination in 
the machine 

database 
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5.2.2. Transfer From File Command 

 

This command is used to transfer data from any .tr3 file in the machine 

database. 

From the main menu select Transfer > From file command. 

 
The following window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Press File button and select the required Transfer file. 

All the record from this file will appear in left part of the window. 

Select any record and a proper destination. For Spectra and Coast-down data a 

Direction must be selected in the machine tree. For Balancing data a Machine 

must be selected. 

You can see the plot before transferring, pressing the Show button. 

Now press Transfer button and the data will be transferred in the destination 

location. 

Instead, you simple can drag and drop the selected item from the file list in the 

final destination. 

After transferring you can, optionally, delete the record from the file list pressing 

the Delete button. 

 
Finally, press Terminate button to conclude the transfer session. 

Destination in the 
machine database 

Press this button to 
transfer the data 

Press this 
button to 
select a 
transfer file 
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6. Route transfer 
 
The followings steps must be done to use the route transfer: 

- Create a route; 

- Download the route definition into Easy Viber Analyzer-Data collector; 

- Perform the measurements; 

- Download the route measurements. 

 

 6.1. Create a new route 

 
 Select Database > Route Edit menu. 

 

 

 

 

 
 

 
 

 
 
 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
Press Add button to add a new route in the list. 

Form the machine database tree select first machine and press Add 

button. 
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The selected machine will be added to the route structure. 

Proceed as above with all machines. 

 

From the route structure you can 

remove some points or directions. 

The removed items will be not 

deleted from the database, just 

will be not transferred in the Data 

Collector. 

 

To remove an item, select it and 

press Exclude button. 

 

Finally, press Exit to save the 

route definition. 

 

 

 

 

 

 

 

 

 

6.2. Download the route in the Data Collector. 

 

 
 Select Transfer > Route > EasyViber menu. 

 

The Route Transfer window will appear. 

 

 

First check the Serial communication port. 
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Establish the communication with the Data Collector. 

Select the route definition and press download button. The route definition will be 

transferred in the Data Collector. 

 

6.3. Download the measurements. 

 

You can download measurements from a route directly in the machine database 

or in a transfer file. 

 

6.3.1. Direct transfer. 

 

Select Transfer > Route > EasyViber menu again. 

 

Establish the communication with the Data Collector. From the Data Collector 

routes list select the route. Press up-load button (right arrow button). 

 

6.3.2. Indirect transfer. 

 

Use external program “Route transfer to file”. Create a transfer file (with 

extension .tr4). Transfer the route in this file. 

 

In the SpectraPro, select Transfer > Route > From file menu: 

Browse for the transfer file. Press Transfer button to up-load the measurements 

into the database. 
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7. Importing data 

 
External data can be imported in the machine notepad using Import notes 

command from the Database Menu.  

With this command, you can complete your notes using helpful information from 

the maintenance team. 

Import command is a easy way to add information’s regarding repair process, 

spare parts used or any other information’s, even picture or text file. 

To do this, first you must prepare a text file, with any name, but with (. imp) 

extension. 

The following reserved words can be included in this text file between square 

brackets: 

 
[PLANT] < plant name> <plant name> must exist in the database 

[MACHINE] < machine name> <machine name> must exist in the 

database 

[DATE] < date> in computer format (e.g. dd/mm/yyyy) 

[RTF] < file name> full path and name of a rich text file 

[FILE] < file name> full path and name of a text file 

[PICTURE] < file name> full path and name of a picture file in 

Windows graphic format 

[NOTE] Next lines will be considered to be notes 

to be added. Finish with other reserved 

word or with [ENDNOTE] 

[ENDNOTE]  

* Is considered to be comments. Is not 

transferred. 

 
For the DemoPro database, provided in installation kit an import file example is: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Generally, import files can be automatic generate by other computer software 

used in maintenance activity. 

* Sample import file 

[PLANT] Department #1 

[MACHINE] Machine #1 

[DATE] 23/08/1999 

[NOTE] 

Notes for Machine #1 

[ENDNOTE] 

* Next machine 

[MACHINE] Machine #2 

[NOTE] 

Notes for Machine #2 

[ENDNOTE] 

* End of the import file 
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If SpectraPro not find a plant or a machine in your active database an error 

message will be generate. 

If the software not finds a specific date, will add a new record to your database. 

 
Then you execute this command, first press Transfer button. A specific window 

will appear and you will be asking to select the transfer file, somewhere in the 

accessible network. Select the file and press Open. The import procedure will 

begin. Finally, press Terminate button to finish the import procedure. 
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8. Database maintenance 
 

From time to time run Maintenance command to optimize the dimensions of 

your databases. 

 

You can select two way of deleting some old measurements: 

 

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

 

 
• by date 

• by number 

 

The baseline spectrum will be not deleted. 

 

Notepad records associated with measurements can be deleted only the checkbox 

“Delete associated notes” is checked. 

 
Deleting process can take a long time, especially for long databases. 

 
Repair and compact command can be used only with MS Access type 

databases. 
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9. Database filters 
 

9.1. Why is using a Filter? 

When is manipulate large SpectraPro machine database, you will find that is 

difficult to access a specific machine, point or direction. For this reason the user 

can use a “filter” condition applied to the machine database to reduce the items 

number. A filter is in fact a collection of some machines, points and directions, 

defined as a route. Many filters can be created for a machine database. This 

filter’s is named also Route. 

 

9.2. How to build a filter? 

Any numbers of filters can be built using the Edit Filter command from 

Database menu. 

Activate this command and the Filter Editor will be activated. 

Press Add button to add a new filter.  

 

An existing Filter can be renamed or deleted pressing the Rename or Delete 

buttons. 

Once a new filter is created, you can add to the Filter some machines. To do this 

select any machine from the machine database tree area and then press Add 

button. In same Filter a machine can’t be added twice. 

In place to add a machine you can add directly all the machines from a 

department. To do these select a department and push the Add button: 

All the machines belonging to the selected Department will be added.  

To remove a machine from the Filter tree, select the machine and push Remove 

button: 

 
You can remove entirely a Department, also. To do this, select a Department 

from the Filter tree and press same Remove button.  

 

From an existing Filter you can exclude some Direction: 

 
In a filter you can arrange the items using Arrange buttons. To do this, first 

press CTRL key from the computer keyboard and after that click on Up or Down 

Arrange buttons 

 

9.3. Filter activation. 

To activate a filter proceed as follow: 
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Select Settings > Set filter. 

 

Select a Filter definition or a Route (A Route can be used anytime as a Filter). 

You can press Show button to see the Filter contents. 

Press Change button to activate the filter. 

You can do the same from the SpectraPro Status bar. Just click on Filter icon: 

 

If a filter is active, the filter name will appear in the Status Bar also. 

To cancel the filtering, just select whole database as filter. In above example the 
database name is DemoPro. 

 

NOTE: Then the database is filtered some machine, not included in the 

Filter, will not appear in the machine tree.  

 

 

In the below example, the DemoPro database tree 

will appear as follow: 

Only Department #1 is visible, because the Filter 

includes only this Plant. 

After the database name also the Filter name is 

shown. 
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10. Viewing plots 
 
SpectraPro can display the followings plots: 

- Trends (for total value, BC, Envelope, Temperature, Speed, Manual 

Entry values and also Coast Up and Coast Down graph) 

- Spectra (for vibration measurement and Envelope) 
- Time signal plots 

 

10.1. Trend plots 

Trend plots can be show for any View or from Edit windows. 

Then a Trend Plot is shown you can take a large number of actions to customize 

the graph. 

Majority of these actions can be done using the pop-up menu, activate with 

right-mouse button. Other actions can be taken using the mouse or/and 

keyboard. 

Also you can use the dedicated buttons from the Toolbar. 

 

10.1.1. Actions with mouse and/or keyboard 

 

 

In the following picture you can see all the action you can take using the mouse 

or the keyboard. 
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Unit and average – The trend unit for the Total value of vibration are, all the 

time, in according with the setting of the Alarm levels (in Edit Database window). 

The unit and average can’t be changed. 

Gain – Then the trend is show for the first time, the gain is set in respect of the 

biggest Total value from the trend (AUTO mode). 

The gain can be change clicking and after this dragging the upper horizontal line 

of the grid 

If you drag in down direction, the gain will decrease if you drag in upper direction 

the gain will increase. 

A double-click in y-axis label area will restore the auto-gain. 

The gain for BC can’t be adjusted. 

 
Cursor – Then a trend are shown, the cursor is placed on last (most recent) 

measured point. 

You can place the cursor also in the other position using the mouse (click in the 

new position) or using left and right arrow from the keyboard. If the 

synchronize cursors command is check, depending on link level (Synchronize 

to menu) the cursors in other trend will move. 
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10.1.2. Actions from the popup menu 

 

 
The Trend Menu can be activated in each Trend Plot with a right mouse click. 

The Menu has the following actions: 

 
 

Copy – This action copy the plot in clipboard or in a 

text editor. You can use also CTRL+C. You can paste 

the clipboard contents in the notepad with CTRL+V. 

 

Grid – The grid of the trend can be shown on hide 

using this action 

 

Show spectrum – Selecting this action the 

spectrum associated with the trend cursor will be 

shown. 

 

Show Notepad – Selecting this action the Notepad 

associated with the trend will be shown. Notepad 

can also be activated with the specific button from 

the toolbar. 

 
Show machine picture – If you select this action the machine picture will be 

shown in a separate window. 

 
Alarm limits – You can make visible, with this action, the alarm limits for the 

selected trend.  

 
Synchronize cursor – this action activates or deactivates the linking 

between the cursors for other trend plots. If a large number of trend 

plots are displayed is better to not synchronize the cursors. 

 

 
 

Use same scale for all – This command is an action, and adjusts the gain for all trends 

according with the gain of active trend, depending of the link level. 
 

Link to – You can synchronize trends cursors and make same gain for all the 

trend plots, depending on link level: global (for all active trends), machine or 

point level. 

 
 

 

 

 

 

 

 

Colors – You can customize the color for: 

- Main cursor 

- Axis background 

- Axis foreground 

- Trend grid 
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- Trend overall alarm line 

- Trend bearing alarm line 

- Trend background 

 

 

 
You can save these new colors using Save command. You can restore the default 

colors using the Set Default command. 

 
 

Report – Using this command a trend report will be 

generated. After previewing, you can print the report to 

the system printer. The Report can be made directly in a 

text editor also. 

 

 

10.1.2. Actions from the toolbar 

 
Notepad button – When this button is pressed the Notepad will be activate in 

accordance with the active Trend plot. 

 

10.2. Spectrum plots 

 

Then a spectrum plot is shown you can take a large number of actions to 

customize the graph. 

Majority of these actions can be done using the pop-up menu, activate with 

right-mouse button. Other actions can be taken using the mouse or/and 

keyboard. 

Also you can use the dedicated buttons from the Toolbar. 

 
 

 

10.2.1. Actions with mouse and/or keyboard 

 

Click here to select 
the desired color 

Select the item 
for color change 
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In the following picture you can see all the action you can take using the mouse 

or the keyboard. 

 

 
Gain – Then the spectrum is for first time shown the gain is set in respect with 

the overall value of the vibration (AUTO mode). The gain can be change clicking 

and dragging the upper horizontal line of the grid. If you drag in down direction 

the gain will decrease and if you drag in upper direction the gain will increase.  

A double – click in X-axis labels area will restore the Auto gain. 

 
Frequency range – If you click and drag the y –axis of the plot, you can adjust the 

minimum frequency range. If you drag in right direction, the minimum frequency range 

will increase. 

Similar, you can increase the maximum frequency range, clicking and dragging 

the last vertical line of the grid. Difference between maximum and minimum 

frequency must be at minimum 50 Hz (3000RPM). 

A double click in Y-axis labels zone will restore the whole frequency range. 

 
Zoom – You can enlarge the plot with a double – click, anywhere in the plot area. 

To restore the spectrum plot to initial size double-click again. 

 

Main cursor – Main cursor can be activated with a click in plot area. The main 

cursor has a label associated. You can use also the Left or Right arrow keys for a 

slow moving of the cursor or CTRL + Left (CTRL + Right) arrow keys for a fast 
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moving of cursor. Press keys 0 to 9 to move the cursor to the shaft frequency or 

to its harmonics. Move the cursor label up or down using the UP/DOWN arrow 

keys. 

 

Shaft Speed cursor – The shaft speed cursor is shown like a small triangle near 

x-axis. With the mouse, you can adjust the position of this cursor. 

 
If you select from the pop-up menu the command: Bearing tools – Find best 

shaft speed, the cursor will be move under the biggest peak located near the 

value give to the shaft speed cursor in Edit command. 

 
10.2.2. Actions from popup menu 

 
The Spectrum Menu can be activated in each Spectrum Plot with a right mouse 

click. 

The Menu has the following actions: 

 

 
Copy – This action copy the plot in Clipboard. You 

can use also CTRL+C. You can paste the clipboard 

contents in the Notepad with CTRL+V. Also you 

can copy the plot in a MS Word document file. 

First copy action in MS Word will open a new 

document. Consecutive copy action will insert the 

plots (any) in the same document file.  

 

Grid – The grid of the spectrum can be shown or 

hide using this action. 

 

Show trend – selecting this action the trend 

associated with the spectrum will be shown. 

 

Show Notepad – Selecting this action, the 

Notepad associated with the spectrum will be 

shown. Notepad can be activated also with the 

specific button from the toolbar. 

 

Show machine description – The machine 

description editor will be opened. 

 
 

Show machine picture – The machine picture will be shown. 

 

Reference spectra – The reference spectra (Baseline spectra), if exist, will be 

draw in the same plot with black lines. The Reference spectra have its own 
cursor, synchronized with the Spectrum cursor. Using the mouse, pointed in the 

origin of Reference spectrum axis, you can move the reference spectrum where 

you want in the plot area. If you want, you can place the reference spectrum over 

the actual spectrum. 

 

Main cursor – Determine how the cursor will move in the plot: 

- Peak locked – When a peak is detected, the cursor will be place on 

maximum calculate peak. A small blue icon will indicate peak 

detection. If a peak is not detected, the cursor will move with spectrum 

resolution steps. 
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- Frequency line – The cursor will follow the spectrum lines. 

- Free – The cursor is moved with one pixel step. The peak amplitude 

will be calculated with linear interpolation between spectrum lines. 

 

Speed tools – Determine how the software will place the speed arrow: 

 
 

 
o Calculated – The speed arrow will be place in the position 

calculated from the actual spectrum (around the defined values). 

The software tries to detect a peak (a higher line between other 

two smaller) around the defined shaft speed. If a peak is found, the 

exact frequency and peak amplitude are calculated. If a peak isn’t 

found, the speed arrow is place on the defined frequency 

o Defined – The speed arrow will be place as is defined in Database 

edit menu. 

o Measured – The speed arrow will be place in the position where was 

measured. If the shaft speed wasn’t measured in time of spectrum 

acquisition, the cursor will be placed in the defined position. 

o Saved shaft speed – The speed arrow will be place in the position 

saved before, using the Save speed current command. The speed 

value is saved only for the selected spectrum or for all spectra 

belonging to the machine (see Adjusting speed paragraph). 

 
Harmonic cursors – As default, up to 10 harmonic cursors can be shown, 

together with the main cursor, but you can change this number in the Settings > 

Optional settings menu. 

  

Side band cursors – As default, up to 10 side band cursors can be shown, 

together with the main cursor, but you can change this number in the Settings > 

Optional settings menu.  

  

 

Fault frequency cursors – This is a powerful tool for fault identification. In a 

toolbox window, all the defined fault frequencies appear. 

 

 

Click here and the 
auxiliary defect cursor 

will appear in the 
spectrum plot 

Click here and auxiliary 
defect cursors will 

appear together with 
the harmonics and 

sidebands 

Select the numbers 
of the harmonics and 

sidebands 

Adjust the contact 
angle (only for 

bearings) 

Shaft speed arrow 



SpectraPro
©©©©
 User Manual 

 

 
62 

 

 

Any selection will update in real time the spectrum plot. Last selection is also 

saved for later use. 

 

Fault list – The Fault list table will be shown. You can do this action also from 

the Main menu toolbar. 

Depending of the gap setting, the labels attached with the fault frequencies will 

be shown also, accordingly. 

 

Show with- Same cursors – If on the screen is shown more that one spectrum, 

if you select this action the cursors from all spectra plots will be synchronizing, 

depending on link level (Link to action). 

 

Show with- Use same – This action set the synchronism level for range, if more 

than one Spectrum is shown. You can select between Frequency range, Amplitude 

range or for both. 

 

Show with- Link to – This action set the synchronism level if more than one 

Spectrum is shown. The synchronism level can be one of Global (for all the 

spectra plots), on machine level, on point level or on direction level. 

 

CPM / Hz – You can change anytime the Y-axis unit, selecting CPM or Hz. 

 

Colors – You can customize the colors in the spectrum plot. You can change the 

colors for: 

• Main cursor 

• Harmonics cursors 

• Bearing cursors 

• Axis background 

• Axis foreground 

• Overall barograph 

• Spectrum grid 

• Spectrum line 

• Spectrum background 

 

 

 

 

 

 

 

 

 

 

 

 

 
You can save these new colors like default color, or to restore the original colors, 

using Set default command. 

 

Export – You can export whole spectrum in any transfer file (having extension 

.tr3) 

 

Click here to select the 
desired color Select the item for 

color change 



VMI AB SWEDEN 

 

 

 
63 

 

 

Report – Using this command a spectrum Report will be generated. After 

previewing, you can print the report to the system printer. For more details see 

Report preview.  

The Report can be transferred also in a MS Word Document. If no document is 

open, a new document will be opened. Consecutive reports will be inserted in the 

same document file. 

 
10.2.3. Actions from the toolbar 

 

In the Main Menu some Toolbar buttons is dedicated for Spectra Plots: 

 
 

 
 
 

 
 
 
 
 
 

 
Notepad button – When this button is pressed the Notepad will be activate in 

accordance with the active Spectrum plot. 

Dynamic table – A table with first 30 fault frequencies can be shown: 

 

Fault toolbox –Activating this action the Fault frequencies toolbox window will 

be shown. 

Gap – Depending on the gap, in the dynamic table less or more frequencies can 

be labeled. 

 

If the gap is too small and the fault frequencies is not equal with fault definition, 

plus or minus the gap value, in place of label a question mark will be displayed. If 

the gap is too large, for the same frequency more than one label will be shown. 

 

Zoom – This action can be used for a fine tuning of the shaft speed: 

Notepad 

activation 

Dynamic 

defect table 

Gap 

adjustment 

Defect 

toolbox 

Zoom  
In/out 

Defect frequencies label 

Unknown frequencies 

Clicking here you 

can change the 
order in the list. 
The list can be 
ordered by value 

of frequencies, 
value of vibration 
amplitude or in 
natural order. 
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10.2.4. Other settings in the spectrum plot 

 

 
The main cursor shape can be selected using the Optional Settings command 

from the main Settings menu. 

 

 
  

Main cursor can be: 

- Line (default) 

- Target type 

- Cross type 

 

Just click on option you want and the cursor shape selected will be shown in 

spectrum plot all the time from now. 

Also you can adjust the cursor thickness (default is 1 pixel)  

 

The thickness of the spectrum line can be adjusted with a proper setting of the 

Width. 

 

Maximum numbers of harmonics cursors and side-band cursor can be adjusted in 

the same tab. 

This cursor and associate label 
indicates the real frequency of the 
spectrum peak. 

The real peak frequency calculates 

from the existing spectral line. The 

real peak is also reconstructed. 
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Once set, any of above will be save in the SpectraPro.ini file. 

 
10.2.5. Adjusting speed 

 

Begin with SpectraPro SP8, new enhancement has added to the Speed tools 

menu. 

 

A major task in spectrum analysis is to determine, with higher accuracy, the 

correct speed for each spectrum. Almost all fault frequencies are associated 

with the shaft speed. A small error in shaft speed determination can produce 

larger errors in fault frequencies calculation and as a consequence, a poor 

diagnosis process. 

 

A solution can be to measure the spectrum from the route using speed 

reference (active tachometer input). This action is difficult to be done in most 

cases, because a speed sensor must be fitted to the each machine shafts. 

 

Method Using the Measured speed, described bellow, allow a correct shaft 

speed calculation even if only a single measurement belonging to the machine 

has a speed reference. The algorithm works also if the machine has different 

shafts speed. 

 
Method Using the Saved speed, allow a correct shaft speed calculation 

without to collect any spectrum with speed reference sensor. For a single 

spectrum belonging to a machine, the speed must be manually set. After that, 

using a back-calculation, all the spectra will appear with correct speed cursor. 

10.2.5.1. Using the Measured Speed 

For a new un-loaded spectrum having the speed measured in time of the data 

acquisition, the Speed tools Menu appears as below: 

 

In this example, the Measured shaft speed is 

2952.1 RPM. 

The Saved shaft speed item is disabled, because 

no any speed was saved before. 

Because Defined speed is set to 7560 RPM, the 

Calculated speed, in our example, is the same. 

Calculated speed is calculate around the Defined 

shaft speed (± 20%). 

 

For a new un-loaded spectrum, without speed measurement in time of the 

data acquisition, the SpeedTool Menu appears as below: 

 

 

 

 

Measured item is disabled, because the speed 

was not measured in time of data acquisition. 

 

Others items are the same. 
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To set the proper shaft speed for all machines directions, proceed as follow: 

- Identify the spectrum having Measured item enabled. 

- Click on Measured item to extend the menu lines: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Select menu Set to all points. The proper shaft speed will be 

back-calculated, using the speed settings in the database, for all 

the measurements belonging to the same machine and having the 

same transfer time (in fact this means that all the transferred 

measurements from the route belonging to the same machine will 

be settled with Measured speed). 

The result can be seen immediately; just select another spectrum of the same 

machine and the Speed Tool menu will look like bellow: 

  

In our example, the measured speed for this shaft 

is back-calculated to be 1230 RPM. 

 

The calculations use the measured speed of the 

previous point as reference. 

 

 

 

In the QuickView, you can do the settings in seconds. 

 

Now all the spectrum of the same machine, without to be collected with speed 

reference, have the speed cursor in the correct position.  

Of course, is assumed that in time of data acquisition, the machine speed 

remain the same. 
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10.2.5.2. Using the Saved Speed 

For a new un-loaded spectrum, without speed measurement in time of the 

data acquisition, the SpeedTool Menu appears as below: 

 

Measured item is disabled, because the speed 

was not measured in time of data acquisition. 

 

Saved shaft speed item is also disabled, because 

no any shaft speed was saved. 

 

 

To set the proper shaft speed for all machines directions, proceed as follow: 

- Select any spectrum of the same machine. 

- Manually move the shaft speed cursor near the frequency where 

you consider that the speed is correct. 

 

 

 

- From the Main Menu toolbar, press            button. 

- In the enlarged spectrum graph, locate the Best shaft position. This 

is the maximum of the peak, as bellow: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Now press again            button to display whole spectrum. 

- From the Speed tools item, select Save current speed and Save 

to all points item. The proper shaft speed will be back-calculated, 

using the speed settings in the database, for all the measurements 

belonging to the same machine and having the same transfer time 
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(in fact this means that all the transferred measurements from the 

route  

- Belonging to the same machine will be settled with Saved shaft 

speed). 

-  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The result can be seen immediately; just select another spectrum of the same 

machine and the Speed Tool menu will look like bellow: 

  

The Saved shaft speed is checked, even if was 

not saved for this measurement. 

 

The calculations use the measured speed of the 

previous point as reference and the speed cursor in 

the spectrum is placed according with the 

calculation. 

 

 

 

In the QuickView, you can do the settings in seconds. 

Now all the spectrum of the same machine has the speed cursor in the position 

decided by you.  

Of course, is assumed that in time of data acquisition, the machine speed remain 

the same. 

  

 

 

 

 

10.2.6. Pseudo-spectra. 

 

If the measurements are down-loaded from a XVIBER Instrument and the 

Instrument isn’t set to collect spectra, the measurements don’t contain spectrum 

line. Instead, only the first highest spectrum peaks are transferred. 
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Still SpectraPro will show the spectrum plot, but only with 10 lines. This is a 

pseudo-spectrum: 

 

 
 

In such cases, the fault frequencies are calculated with a high error margin. Also 

all other spectrum lines has zero amplitude values. 

 

10.2.7. Spectrum in mV unit. 

 

With the EasyBalancer or with EasyViber Instruments, mV spectra can be 

measure but only off-route. These spectra have special meaning: the engineering 

unit can be any, not only vibration unit. 

 

The mV spectra can be shown only in the Edit windows and in List View. 

 

Bellow is shown an mV spectrum: 

 

 
 

When the mV label is selected the following window will be shown: 

 

Now you can edit the unit and set the 

correct transducer sensitivity (in 

mV/unit). 

The settings will be save in the database. 
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10.3. Time signal plots 

 

Time-signal can be collected in either route mode or off-route measurements, 

only with Easy-Viber Analyzer. 

 

The time-signal graph can be very usefully as a complementary plot in machine 

diagnosis process. 

 
 To add a user label in the plot area, proceed as follow: 

- Move the mouse pointer in the position where the labeling will begin. 

- Double-click (left button) and keep press the mouse left button. The 

labeling will begin, showing a blue colored label on screen. 

- Move the mouse pointer in the end position and just click once. 

- The label will show the distance between the start and end position (in 

seconds and in frequency units). 

A short comment can be added to the label. Click right in the label area. A 

small window will be shown: 

 
 

 
 

Enter your comment and press ENTER key. The comments will be added 

to the label. 

 

A label can be deleted. Proceed as above, but select Delete from the 

window. 

 
More than one label can be added to the time-signal plot. 

The labels are stored in the machine database for future use. 
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10.3. Coast-down/ coast-up plots 

 

Coast-down and coast-up graph can be collected off-route only. 

 

These graphs can be viewed only in the Edit window or in Show selected 

information view. 

 
 
 

 

 

Each plot has a popup menu: 

 

User can change the frequency unit (RPM or Hz). 

The plot colors can be change using Color menu item. 

From popup menu, the user can copy the graph in Clipboard or in 

MS Word and also to create a report. 

 

The graph can be exported in any tr3 transfer file. 
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11. Viewing data 
 
In order to analyze the collected data you have on your choice many ways of 

viewing data: 

• A collection of trends and spectrum selected by you (View > Show selected 

information). 

• A Quick View session, in which you explore the machines, the trends and 

spectrum associated with the selected direction (View > Quick View). If Bands are 

defined, also Band Trends are available. 

• Trends and spectra from whole machine in which you can see at once, all 

this trends and spectrum associated with the selected machine (View > Show 

spectra from whole machine). 

• A List View in which you can see at once, all Total values (vibration, Bearing 

Condition and Envelope) for the whole machine (View > List View). Also the 

Alarm status is indicating. 

• A Band View in which you can see, at point level, all vibration total values 

and Band values (peak average for the band width). Alarm status for above is 

also indicated (View > Band View). 

 

11.1. Show selected information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Then you select this command, a specific window will appear in the screen, which 

will allow you to choose the department, the machine, the point and the wished 

direction. Choose are done selecting a certain direction, with the mouse, in the 

above-mentioned order. When the direction is selected, in the upper right side it 

Double-click on 
any item or drag 

and drop in the 
"Spectrum and 
trends to show" 

window 

Double-click to 
release an item 

from the list 

Double-click on any 
"Direction" item or 
drag and drop in 

the "Spectrum and 

trends to show" 
window 

 

Press this button to display 
the plots 
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appears a list with all collected spectrums for that direction. Colored small icons 

indicate also an alarm condition for the measurements.  

 

 

A check mark icon indicates the base line spectrum, if any. Coasts down 

measurements are marked with a blue icon. Now you can select a collection of 

trends and spectra to be shown. Just double – click to any trend or direction and the 

item will be move to the show list. 

 
In place of double – clicking you can drag and drop any Direction or Spectrum to 

the show list. 

If you want to not display some items from the show list, just double – click on 

that items and item will be remove from the list. 

 

Finally, press Show button, and the entire list will be shown. 

After you displayed some trends and spectrum – set, the main window remain 

active and you can select other trends or spectrum. Although it can display a 

large number of information’s on a single screen, it is recommended to limit the 

number of simultaneously opened plots, because the plots will have smaller and 

smaller sizes and many details will be lost. 

 

When one or more plots are displayed, you can use Window Menu to arrange the 

plots in the screen. 

You can clear the screen using Clear All command or you can copy in the 

Clipboard any plot using Copy to clipboard command. 

 

 
For details regarding an efficient way of using the spectrum and trends plot, see 

also: Spectrum plot and Trend plot 

 

Advantage of using Selection view: 

- Any trend, spectrum or coast down measurement can be displayed 

in a single screen. 

- Number of plots displayed is limited only to the screen size. 

Disadvantage of using Selection view: 

- Long time for selection of plots. 

 

 

 

11.2. Trend and spectra from whole machine 

 
With this command you can see in a single “scrolling” screen all the trends and 

spectrum associated with a machine. Last measurements will be shown in the 

spectrum plots. 
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First, select from the hierarchy tree the desired machine. In the right part of the 

selection window, a list with all directions of the selected machine will appear. 

 
Before showing, you can rearrange the list, dragging the items. 

Now you can remove some items for the list (with a double-click) or show the list 

pressing Show button. 

The plots will be shown in trends-spectrum pair 

If you don’t need all the plots, close some of them and use the  Pre-arrange 

Trend/Spectrum command from Windows menu to rearrange the plots on the 

screen. 

If you move the cursor in a trend plot, the contains of the associated spectrum 

plot also will be change, to reflect the actual position of the cursor. 

You can synchronize the cursor in the spectrum or trend plots. 

For more details see also: Trend plot and Spectrum plot 

Finally, use Clear All command from Windows Menu to close all plots. 

   

Advantage of using Machine plot view: 

- All trends and spectra associated with a machine can be displayed 

in a single screen. 

Disadvantage of using Machine plot view: 

- Only plots belonging to a single machine can be shown. 

 

11.3. Quick View 

 
This command shows trends and spectrum in a special way. Then you select this 

command a four-window screen will appear: 

• Database tree 

• Trend plot 

• Spectrum plot 

• Notepad editor 

All four windows are synchronizing. If you move the cursor in the database tree, 

all other windows will be refreshed. 

 

 
If you change the position of the cursor in the trend plot, the spectrum plot and 

notepad contains will be change. 

 
In this way, you can see very quickly all the information’s you need for the whole 

database. 
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You can change the position of the windows in the screen, but you can’t close 

plots windows. If you close tree window, all the windows will be also close. The 

last positions of the windows will be save. 

Use Arrange Quick View command from the Windows menu to rearrange the 

window in a convenient way. 

 

The Notepad Window can be closed any time. 

  
Advantage of using Quick View: 

� Any trend or spectrum from any part of the database can be shown. 

� Quick access to any plot from the whole machine database 

 

 Disadvantage of using Quick View: 

� Only a single pair trend-spectrum can be shown in same time. 

 

 
11.4. Band View 

 
A band is a defined portion of a FFT spectrum. The bandwidth can be calculated 

with the following formula: 

 

 Band Width= (Central Freq + Gap) – (Central Freq - Gap) = 2 X Gap 

 

The amplitude value of the band is calculated with the formula: 

 

 Amplitude= Sqr( ∑ L2
i)      where: 

 

Li =Spectrum line inside of Bandwidth 

 
Each band has a specific frequency, generally a fault frequency or a multiple of it. 

In the SpectraPro, for each Direction, up to 32 bands can be defined. 
 
11.4.1. Defining Band 

  
The bands can be defined in the Database Edit Menu, on each Direction level. 
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The Bands definition can be made after all the fault frequencies and alarms are 

defined for the selected Machine.  

To start an editing session, just press the Narrow Band button: 

 

 
 
The Narrow Band Setting window will appear: 

The editing window contains a spreadsheet (or a table) in which you can 

edit up to 32 Bands. 

The table has the following columns: 

 

Type – In this column can be selected one of the following items from a 

combo box: 

 

• Defined – The Band central frequency will not be 

calculated from the spectrum, just the defined 

frequency will be used to calculate the Band 

amplitude. 
 

 
• Calculated – The Band central frequency will be re-calculate according 

with the real shaft speed from the Spectrum. The actual frequency is 

calculated around the Defined frequency with a gap of ± 2 X Spectrum 

Lines. If in this range a spectrum peak isn’t detected, the Defined frequency 
band will be used instead. If the Defined frequency is zero (normal setting for 

variable speed machine), the best shaft speed is considered to be the highest peak 

in spectrum. 

 
• Measured – The Band central line is calculated in relation with 

measured speed, in time of data acquisition. If the speed wasn’t measured, 

the frequency of the band will be zero! Never define Band with Measured 

type, if you are not sure that the speed will be measured together with the 

spectrum. 

 
Band name. – This item must be added by the user to identify later the 

band. 

 
Press this button! 
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Frequency – This is the central frequency of the band. In time of editing 

must be selected from a list. 29 possible fault frequencies are available in 

the SpectraPro. These frequencies must be defined before. Only the defined 

frequency will appear in the list. In the following table are described the 

fault frequencies defined in the SpectraPro; 

 
Frequency Description 

Primary reference speed Defined at Machine level, normal 

the drive rotational speed (always 

exist) 

Secondary reference speed Defined at Machine level, normal 

the driven rotational speed 

Line frequency Defined at Machine level, this is the 

line frequency, 50 or 60Hz. 

Pole pass Defined at Machine level, this is 

Pole pass for asynchronous electrical 

motors. 

Rotor bar pass Defined at Machine level, this is the 

Rotor bar pass for asynchronous 

electrical machine 

Belt Defined at Machine level, this is 

Belt fault frequency 

Multiply frequency Defined at Machine level, these are 

any multiply frequency of above. In 

the SpectraPro, up to 5 Multiply can 

be defined  

Shaft Speed Defined at Point level, this is the 

shaft speed defined as a multiply of 

the primary or secondary reference 

speed (always exist). 

BPFO, BPFI, BSF, FTF Defined at Point level, these are the 

bearing frequency faults. In 

SpectraPro, for each Point, up to 4 

bearings can be defined 

Gear box fault Defined at Point level, this is the 

gear mesh fault frequency. 

 
A special, 1 Hz fixed frequency can be also added as Band frequency 

definition. 

 

Value (Hz) – This column can’t be edited. In the column is indicated as 

reference only, the actual frequency of the fault as is defined before. In time 

of showing data, this frequency is re-calculated according with the Type 

setting. 

 

Multiply –This is a multiplier of the fault frequency selected in the 

Frequency column. Using the Multiply factor, many Bands can be defined, 

having the same fault frequency as reference. 

 

Gap (Hz) - This is the gap of the Band. The gap can be selected from a list 

and can be from 0 to 50 Hz. As a general rule, the gap can be at least the 

spectrum resolution. If the gap is selected below spectrum resolution, the 

band will be the peak amplitude. 
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If you select the gap value zero, the band will be the peak amplitude. 

Use a zero gap value if you intend to have a trend for a peak instead to 

have a trend for a Band. In run-time, for each measurement in the Trend, 

the correct frequency will be calculated, but only if you select Calculated 

type Band. If you select Defined type Band, because the peak value can 

shift, the Trend results can be erratic.  

 Using fixed frequency of 1 Hz and gap, you can define fixed Bands. To 

define a band for low frequency from 0 to 6 Hz, select as Frequency the 

Fixed (1Hz) frequency, Multiply to be 1 and Gap also 5 Hz. The band will 

have a range from 0 to 6 Hz. 

 

Warning – This is the Warning level of alarm, defined in the units and 

average selected in the Alarm Settings. Automatically setting is also 

possible, if a Baseline spectrum is defined.  

 

Danger – This is the Danger level of alarm, defined in the units and 

average selected in the Alarm Settings. Automatically setting is also 

possible, if a Baseline spectrum is defined.  

 

Active – If active is set to YES, the band can be shown in “QuickView” or in 

“BandView”. If the setting is NO, the Band is only defined, but can be 

shown. 

 

In the Band definition window a series of buttons are available in editing 

time: 

 

  Delete – Use this action to delete the selected portion 

form the table. 

 

  Copy – Copy all table contents in the Clipboard. Later, 

you can Paste the table contents to another Direction in Tree. 

 

  Paste – If is enabled, you can Paste the table contents 

previously copied. 

 

  Copy to all – Copy the contents of the table definition 

and apply the contents to all Direction from the selected Point 

 

  Alarm – Automatically apply a calculated level alarm for 

all the defined faults, based on Baseline spectrum. On same 

Direction must exist a Baseline, otherwise the action fail. 

 

  Save – Save the definition in the Machine Database. Each 

time when you change an item in table, before to Exit, you must 

save your change. Automatically saving is done after Delete 

and Paste action. Also after Copy to all action, the band 

definition form other Directions are saved 

 



VMI AB SWEDEN 

 

 

 
79 

 

 

Editing items in the table are very simple: Move the cursor in the cell where 

you intend to change something. Just type directly the new value. If a 

combo box appears, use the up and down arrows to select the proper item 

and press Enter to complete. If the cell is a direct editing field, just type the 

numbers or letters. To complete, press Enter key. 

You can use also the mouse, just click in the cell you intend to edit. Once 

you click the mouse in another cell, the previous cell editing mode finish. 

 

11.4.2. Recommendation for Band definition 

 
  
 A large numbers of bands can be added in the Database. Some of them can be 

usefully, but some of them not. Follow the rules described before, to not waste 

time and to add more functionality in your software. 

 

� Add bands for Shaft Speed and also for 2 X Shaft Speed and 3 X 

Shaft Speed. The best Gap setting is the spectrum resolution, but 

not less than 1 Hz. Band Type must be set to Calculated. 

� Add a band to Line frequency and to 2 X Line Frequency (if you 

have an asynchronous electrical motor). The best Gap resolution 

must be set as above. Band Type must be set to Defined. 

� Add Belt fault if the assembly has a belt. The best Gap setting is 2 

X spectrum resolutions. Band Type must be set to Calculate 

� Add Multiply for motor fan blade and also for pump blade. The 

best Gap is 2 X spectrum resolutions. Band Type must be set to 

Calculate 

� Add bearings fault frequencies, if you have roll bearings. Band 

Type- Calculated. 

� Add a fixed 0 to 5 Hz band frequency. Band type – Defined. 

 
Generally, above bands are required during diagnostics procedure. 

More bands can be added for special machines or for specific purpose. 

  

 

 

11.4.3. Showing Band in Quick View Mode 

  
 

  The bands can be shown in QuickView or in BandView: 

 

 
 
 
 
 
 
 
 
 

In the QuickView, select a Direction and extend the tree. All defined bands will 

appear in the tree. 
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The Trend Plot will be shown in the right side (for the selected band). 

The Spectrum Plot will be shown above. 

 
 
 

In the spectrum the selected band will be clearly marked. If the band has also 

alarm defined, the band will be tri-colour, showing the Warning and Danger 

levels. 

 

 
 

NOTE. In spectrum, the alarm levels are shown only for reference purpose. 

Remember that, the alarm levels are for the Bands and not for the peak. Always, 

the Band alarm limits will be greater than the peak high, because the band value 

is an average of all the band peaks. Only if the band contains a single peak, the 

alarm level will be valid also for peak. 
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NOTE. If the Gap value is zero, a single line will mark the Band. 

 

A Band report is available from Trend popup menu. 

 
11.4.4. Showing Band in Band View Mode 
 
Showing bans in BandView is very similar with showing bands in the QuickView 

mode. In the left tree appear only the Database hierarchy up to Point level. Once 

a Point is selected, in the right side appears a list showing Total values for all the 

Directions and also the bands values. 

The items have colour icons to indicate the band alarm status. Magenta colour 

denotes that the Warning and Danger limits are zero (no alarm set). 

 

 
 
 
 
 

In the List, a popup menu is available: 

 

 
 

Using this menu, you can show the whole spectrum or the band trend. 

This feature is not the same as in the QuickView.  Each plot required the above 

Popup menu is displayed for the selected item from the table. The plots do not 

reflect the selection changes and must be closed manually.  

You may copy the relevant plots in the Notepad or in MS Word. 

A Band Report is available to be shown in Print Preview or to be inserted in a 

MS Word document. 

No alarm 
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If you intend to re-arrange the BandView windows, select from the SpectraPro 

main menu Windows/Arrange BandView 

 
 
EXAMPLE 

 

Copy the BandTest.sp3 Database in the SpectraPro\Data folder. 

Open SpectraPro software and register the BandTest.sp3 Database 

Activate the BandTest.sp3 Database 

 

In this simple database, 4 bands are defined for each Direction as follow: 

 

 
 

• A narrow band for the PrimaryRPM (17.4 Hz ± 1 Hz) 

• A narrow band for the SecondaryRPM (24.71 Hz ± 1 Hz) 

• A wide band alarm covering the range of 290 Hz ± 50 Hz 

• A wide band alarm covering the range of 190 Hz ± 50 Hz 

 

Alarm settings for the bands are automatically calculated from the Baseline. 

 
Open QuickView and extend the tree up to bands level. Select any one band. In 

the right side, the trend plot will be changed to show trend for selected band. 

Also in the spectrum plot, the band will be marked. 

 

Notice that to display the normal QuickView style, just not extend the Direction 

item. 

 
Now you can move the cursor in the trend and the spectrum plot will be 

refreshed. Each time you move the cursor, the peak found in the spectrum plot is 

slightly move, but always a peak is found correctly. 

 
The wide bands cover a 200 Hz range, above the SecondaryRPM frequency. 

 

Now you can return to the Database Edit and add more bands definition for all 

major faults found. 
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11.4.5. Band Alarm in tree 
 

When you update the alarms in the Database (Command Update Alarm Status 

in Database Menu), 

The following attention message will appear: 

 

 
 
Now you have two choices: 

- To press NO and the bands alarm will be not update in the database 

tree 

- To press YES and the bands alarm will be also include in the 

database tree. 

 

If the database is large and many bands alarm are defined, the above action can 

take minutes. 
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Also you must consider the followings: 

- The alarm in tree (coloured icons) is a good indication for you that 

something wrong is happened with your machine. In fact this is 

the first information regarding machines running conditions. 

- If you add to the alarms also the band alarm and many band 

alarms are defined for the machine, the probability to obtain a 

“coloured” icon for machine is very high. In majority of the cases, 

the machines alarm will be in “red” status. 

Have a look bellow: 

 

In the machine tree, the MACHINE1 is in Danger 

condition: 

Because the point P4 is in Danger alarm, also the 

MACHINE1 and DEPARTMENT1 are in Danger alarm. 

If you expand the tree more, you can see that the 

problem isn’t the total value of the point P4, but the 

“Secondary” band, because the total value of the 

vibration in Point P4 is bellow the Warning limit. 

 

 

Showing band alarm in tree can create confusion, so all the time is your decision 

if the band alarms will be added or not to the database alarms update.  
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11.5. List View 

 
Using List View you can see the alarms status for all the Machine Points in a 

single list, without the bands alarm included. 

 

List View never includes the bands alarm.  

 

 

 

 

 

 

 

 

 

 

 

 

In the List View is shown: 

- Total vibration values 

- Total BC 

- Total Envelope values 

- Manual entry point 

- mV Measurements 



SpectraPro
©©©©
 User Manual 

 

 
86 

 

 

 

 

 
 

 
 

12. SpectraPro Reports 
 

The following pre-defined report is included in the SpectraPro software: 

- Job Report 

- Machine history Report 

- Machine description Report 

- Transfer Report 

- Un-measured Machine Report 

- Diagnosis Report 

Majority of them can be user customize. 

 

Any report can be send to a text editor for more modification. 

 

12.1. Job Report 

 

The Job Report contains the last notes made by you for the selected machines. 

This report is addressed to the maintenance team. 

The notes are a consequence of the diagnostic process, using the measurements 
unloaded from the data-collectors. 

 

 

 

 

 

 

 

 

 

 

 

 

 
First select the machines from the hierarchy tree. Just double-click on each 

machine or drag and drop the machines in the selected machine list. 

You can remove some machines from this list, with a double click. 

Now, if you use the software for the first time, you must customize the header 

and the body of this report. 

 

To edit the header press Header button. A specific window will appear.  

 
 

 

 

 

 

 

A double-

click here will 

remove the 

machine from 

the print list 
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In the pop-up menu (activate with a right-mouse click) you have some reserved 

word, all included in square brackets. This words will be replaced in the final 

report, according with the actual contains from the database. In the Job Report 

Header you can add the following items: 

 
[Date] – Current date 

[Time] – Current time 

[DBas] – Active Database name 

 

 

You can preview a sample of the header pressing 

the Preview button from the toolbar. 

 

 

 

The last contents of the header will be automatically saved for later use. 

If you want to have more then one type of header, save contain of the header in 

a file. In this way you can customize how many header type you want. 

 

Next time, you can restore from the saved file the contents of the header. 

 

Pressing Picture button from the toolbar you can include a picture in your header 

(e.g. company logo). 

The Header Edit Window shows the header to 1:1 scale depending from your 

printer setting. 

 
In very similar manner you can customize the body. Press Body. 

 

 

In the pop-up menu (activate with a right-mouse click) you have some reserved 

word, all included in square brackets. This reserved words will be replaced in the 

final report, according with the actual contains from the database. In the Job 

Report Body you can add the following items: 

 
[MPic] – Machine picture, defined in the 

Database Edit 

[Note] – Contents of the last Notepad contents 

[MPar] – Department name 

[MNam] – Machine name 

[MDes] – Machine short description 

[Ndat]  -  Last Notepad entry date 

[DBAs] – Active Database name 

 

 
Before printing you can edit contain of the notes. Use Notepad button, but first 

select the desired machine from the Selected machine list. 

 

Finally press Print button and the Report Preview windows will be activated 

 

See Report Preview for more details. 

 
12.2. Machine History Report 
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The Machine History Reports contain all the notes for a selected machine. 

 

 

First select the desired machine, and decide if you want a report with all the 

history or a partial report. 

 

Now, if you use the software for the first time, you must customize the header 

and the body of this report. 

 
To edit the header press Header button. A specific window will appear.  

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 
In the pop-up menu (activate with a right-

mouse click) you have some reserved word, 

all included in square brackets. These words 

will be replaced in the final report, according 

with the actual contains from the database. 

 

 

 

 

This item will be 
replaced with the 
actual machine 

name 

Paper size, 
depending of the 

Printer Setup 

Preview 
button 

Type here your 
Company name 

Type here the name 
of the Report 
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You can preview a sample of the header pressing the Preview button from the 

toolbar. 

The last contents of the header will be automatically saved for later use. 

If you want to have more then one type of header saves the contents in a file. In 

this way you can customize how many header type you want. 

Next time, you can restore from the saved file the contents of the header. 

Pressing Picture button from the toolbar you can include a picture in your header 

(e.g. company logo). 

 

The Header Edit Window shows the header to 1:1 scale depending from your print 

setting. 

 

In very similar manner you can customize the body. Press Body. 

 

Finally press Print button and the Report Preview windows will be activated 

 

See Report Preview more details. 

 
12.3. Machine Description 

 

The Machine Description Report contains in the 

body the description of the selected machine. 

First select the desired machine. 

 
Now, if you use the software for the first time, 

you must customize the header and the body of 

this report. 

 

To edit the header press Header button. A 

specific window will appear. In the pop-up menu 

(activate with a right-mouse click) you have 

some reserved word, all included in square 

brackets. This words will be replaced in the final 

report, according with the actual contains from the database. 

You can preview a sample of the header pressing the Preview button from the 

toolbar. 

The last contents of the header will be automatically saved for later use. 

 

If you want to have more then one type of header, save the contains of the 

header in a file. In this way you can customize how many header type you want. 

Next time, you can restore from the saved file the contents of the header. 

Pressing Picture button from the toolbar you can include a picture in your header 

(e.g. company logo). 

The Header Edit Window shows the header to 1:1 scale depending from your print 

setting 

 
Finally press Print button and the Report Preview windows will be activated 

 

 
12.4. Transfer Report 

 

Transfer Report can show any of route transfer in the SpectraPro database. 
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From the list, select the transfer 

date. 

 

 

Press Print button to show the 

report. 

The report can contain all 

measurements or a selection, 

depending on Alarm condition. 

Also the specified number of 

highest peaks from spectrum can 

be shown. 

 

 

 

 

 

 

 

 

 

 

 

 

12.5. Un-measured machine Report 

 

 
 

This report can be usefully to find the machines un-measured from a specific 

date. 

Select the date first and press Search button. 

The report will be shown in the print preview window. 

 

12.6. Diagnosis Report (Defect List Report) 

 

This paragraph describes how to use the Defect List Report for diagnosis purpose. 
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In a machine diagnosis task a major difficulty occur because many information 

are required for a precise diagnose. The computer size is limited, so no all 

necessary spectrum plot can be displayed in the same time.  

 

In the spectrum plot can be shown the fault lines, but if are many, these can’t be 

usable. 

 

The Base line spectrum and the latest measurement are very useful for diagnosis 

also. The alarms limit settled in the machine Edit time can also provide valuable 

information’s.  

 

Using this new report, the user can have access once to all relevant information 

regarding machine condition. 

 

The Defect List Report is a valuable tool to speed-up the diagnosis process. 

 

The Defect List Report is available in the SpectraPro
© 
application begins with SP8. 

 

 

The command is included in the Main menu, under Report menu: 
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12.6.1. Using Defect List Report 

When this command is selected, the following window will appear: 

 

 

 

The Constants window shown the alarm level, for all fault type available in the 

SpectraPro
©
 software. 

The alarm levels are calculated using the alarm defined for Total Vibration values 

(Warning and Danger limits. 

 

 
In this first release, the constants values can’t be adjusted by the user. 

 
 

The report has several tables for each Direction: 

 

- Total value table 

- Fault frequency table – latest measurement 

- Fault frequency table – base line  

- Highest peak value in spectrum – latest measurement 

- Highest peak value in spectrum – base line 

If Base line is not defined, the table with base line information will not appear. 

Is highly recommended to define a base line measurement for each Direction, 

 

 

This can be done in Edit Command. 

 



VMI AB SWEDEN 

 

 

 
93 

 

 

12.6.1.1. Total value table 

  

 
 

In above table appear latest two measurements values together with the base 

line value. If Envelope measurement is defined, also the Envelope magnitude will 

appear. 

If the alarm limits is exceeded, the values appear colored in yellow or red. 

 

12.6.1.2. Fault frequency table – latest measurement 

 

 
 

In above table is shown the values for all defined fault frequency. 

 

 
Fault frequency can be defined in the Edit Window. 

The fault frequency can be define on Machine, Point or Direction level. 

Shaft speed, fist two harmonics and Low frequency are shown always. 

 
 

If the fault frequency represents a peak in the spectrum, the value is marked with 

a trusty flag. If the fault frequency is not a peak, but near, the values are marked 

as not trusty. In this last case the value shown, in majority of cases, DON’T 

represents a fault. 

 

 
All defect frequencies is related with the shaft speed. If the shaft speed is 

incorrectly settled in the spectrum, all the values can be wrong! 

For more information regarding how to set the shaft speed BEFORE to issue this 

Report, please read the document AN 01452 –“Improved speed tool menu” 

 
 

 

12.6.1.3. Fault frequency table – base line. 

 

This table is similar with the previous, but is referred to base line spectrum. 
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A simple analysis of these tables can give a first impression regarding the faults 

evolution. 

 

 

12.6.1.4. Highest peak value in spectrum – latest measurement 

 

 
 

In this table are shown only the first ten fault frequencies, but also is shown the 

changing in magnitude since the last measurement. 

If a peak is not identifying, the Fault name is missing. If this is happened for 

majority of the highest magnitude lines, seems that the fault frequencies are not 

completely defined for that Direction. Return to Edit menu and add all available 

fault  frequencies associated with the Machine. 

 

  12.6.1.5. Highest peak value in spectrum – Base line 

 

The table is similar with the table above, but is shown the highest magnitude 

peak for base line spectrum. 

 

12.6.2. Best practice for a suitable Defect List Report 

 
The Report contains only known information. Lack of information’s will give a poor 

Report. 

Follow the bellow rules to produce a usefully Report: 

- Define as many fault frequencies are possible. 

- Always define a base line spectrum for each Direction 

- Adjust the correct shaft speed in spectrum before to use this Command. 

Measuring the speed in time of data acquisition is the best practice, at 

least for a single Direction. If this isn’t possible, adjust manually the 

correct shaft speed for a single Direction belonging to a Machine and use 

the Speed Tool menu to set the proper shaft speed to all Machine 

Directions. 

- The magnitude values are important. Even low magnitude peak can be 

relevant for the machine conditions. 

- Set the Total value alarms according with a well known standard. Be 

carefully to set other smaller limits for Vertical and Axial directions. Don’t 

use same limits for all measurement direction! 

- Add to the Report your comments from the NotePad. Will be very helpful 

in time of diagnosis process. 

- From information provided by this Report try to find first what faults the 

machine DON’T have, rather then to try to detect the existing possible 

fault. Eliminate, one by one, the inexistent fault and finally you will obtain 

a short list with all possible faults. Now will be much easy to determine the 

real faults!  
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12.7. Print Preview 

 

Before a Report to be printed, the contents are shown in a Print Preview window. 

 

Page selection is used to 

browse between report pages. 

Using Zoom button you can 

adjust the report size on the 

screen 

Press Print button to print the 

report to the computer default 

printer. 

 

Press Word button to copy 

the report contents in a MS 

Word document (the MS Word 

must be installed in your 

computer) 
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13. Updating alarms 

13.1. Introduction 

When the machine tree is shown, the items icons are colored according with 

the actual alarms level. 

 

This is true only if the latest alarms were updated recently. 

 

The actual Alarm Status can be seen looking on the Manual Alarm Update 

button from the Main Menu toolbar: 

 

 
 
If the button is pressed (right picture), the alarms are shown correctly, no 

update is required. 

If the button is not pressed (left picture), the alarms need to be refreshed 

manually. To do this, just press the Manual Alarm Update button. 

 

Because the machine databases can be accessed in the same time from many 

computers across the network, in a network environment only, exist the 

possibilities that the user isn’t informed about the real status of alarm in the 

database tree. 

 

See the schematic bellow. This is a typically accessing diagram for machine 

database in a network: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Any of above users can made some change in the machine database adding 

new measurements. 

In this paper is described how the user can set the SpectraPro in a way to be 

informed all the time about any changing in the alarm status and also how the 

alarms update can be done. 
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13.2. Settings of SpectraPro application 

In order to receive periodically information regarding alarm update status, the 

user must set some option in the Setting > Optional settings window, as 

bellow: 

 

 
 

 

NOTE: The alarm are not updated automatically, just the database is 

checked for new measurements. 

 

 

 

If new measurements exist in the database the Manual Update Alarm 

button will be change to not pressed, as follow: 

 

 

  
 

 

 

If the mouse cursor is moved in the button area, the tooltip text will indicate if 

the alarm update is required or not. 

If the alarm update is required, a manual update is necessary. Just press the 

button and the update procedure will begin. 

 

 

 

NOTE: For medium and large size machine databases, a complete updating 

procedure can take minutes. In time of alarm update, the software is locked 

for the user. This is way a full automatically procedure can’t be 

implemented. 

13.3. Semi-automatic alarm update 
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If in the SpectraPro instance a measurement down-load occur, the user can 

decide if also the alarms update must occur when the transferring 

measurement is finished. 

In any transfer windows a check box is placed in the window lower side. 

Bellow is presented the Manual Entry transfer windows: 

 

Update alarm box is checked as default. When the Exit button is pressed, an 
automatically alarm updating will occur also. 

 

NOTE: If any user form the network perform alarm update procedure, all 

other user will be informed about this. The Manual Update Alarm button 

will change the status to un-pressed. 
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14. SpectraPro general settings 

After the SpectraPro is installed on your computer, you can customize some 

software appearance. 

 

Use Settings > Optional Settings command: 

 

 

 

 
 

 In the General tab you can set the followings: 

- Unit used (Metric or Imperial) 

- Frequency unit (Hz or RPM). This setting can be modified in all the plots 

showing frequency. 

- Alarm status in database tree (See paragraph 13 for more details) 

- Help file. The default help file is SpectraPRO.chm, but the file can be 

changed if a help file translation is available. 
 
In the Trend tab you can set the followings: 

- Dimension (width) of the total value and BC line in trend plot. 

- Number of measurements in the trend plot (default are 24) 

 

In the Spectrum tab you can set the followings: 

- Cursor type and width. The cursor can be show as Line, Target or Cross. 

- Spectrum line width. 

- Number of harmonics for each fault type (default are 10) 

- Number of side bands for each fault type (default are 3) 

 

In the Report tab you can set the followings: 

- Header of each report type. 

- Body of each report type. 
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Once set, the contents of Header and report Body will appear every time when a 

report is shown. 

 

 

If you select Imperial unit for SpectraPro, all the measurement will be 

automatically presented in Imperial units. 
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15. Exchange machines 
 

Sometime you will need to move or copy a machine from a database to another. 

SpectraPro offer a possibilities to move or copy machines between any two 

databases. 

The database can be creating in any Server type. 

 

Select Database > Machine exchange command. 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Both databases must be registered. 

Do the followings: 

- Select the source database from any registered databases. 

- Select destination. The destination database must have at east one 

Department (or Plant). You can’t copy a machine in an empty database. If 

you intend to move whole source database in a new destination database, 

first use Edit command and create the same Departments as in the source 

database. 

- Select first Departments where you intend to copy a machine. 

- Select the machine. The MOVE button will be activating. Press the button 

and the machine name will be moved to the destination. The contents will 

be not transferred yet. After transferring one machine, the item in the 

source tree will advance to the next machine. Press again MOVE button 

up to all machine will be “moved” to the destination.  
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- Select the copy options: you can copy only machine definition or also the 

measurements. 

- Finally, press SAVE button. All the selected machines will be copied to the 

destination. This action can take few minutes. 

 

Using Exchange Machine command you can create a single database using 

the machine stored in several database. 

 

Also you can transform a database type (Example a MSDE Database) in 

another (Example: MS Access Database). This action can be helpful to move 

your databases into another computer. 
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16. SpectraPro translation 
 

SpectraPro is multi-lingual software. The entire program message is stored in 

Message.mdb file, a Microsoft Access databases. 

 

 

In order to have a SpectraPro version in a specific language, the entire database 

must be translated. 

 

 
Then you install the SpectraPro, also some additional executable file is 

automatically installed. For translation purpose run Start > Programs > 

SpectraPro > Translate message software. 

 

 
 

First select any empty text box and fill it with your language name. 

In the table, complete item 1 with your language name (can be typed in your 

local language) 

Now begin translation. Be carefully, in English language all the message are 

shorter as in he majority of other languages! 

If you not fully understand how to translate some propositions, just skip the row. 

You can do this later. 

When you finish, close the translation windows. Your work will be save in the 

Message.mdb file. 
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If you update the SpectraPro with a new Service Pack, don’t be worry. The 

Service pack will not delete your translation file, but will add to this newest words 

or propositions (in English language). You must only run again the Translation 

software and translate the latest messages. 

 

When you close the Translation software the following window will be shown: 

 

Your language will appear in the 

translation list. Just select your 

language from the list and next time 

when you will start the SpectraPro, all 

the message will be in your language. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The latest saved language is saved in the SpectraPro.ini file, as is shown above. 

 

If some messages are not translate, you have the possibilities to made translation 

in time of running the SpectraPro software. 

 

To do these proceeds as follow: 

Locate SpectraPro.ini file in your computer (in a default installation the file will be 

in C:\Program Files\SpectraPro directory). 

Just double-click on file to be opened in NotePad. 

 

Bellow is presented the first part of this file: 

 

 [General] 

Language=1 

MessagePro=C:\SpectraPro\MessagePRO.mdb 

TranslateMode=0 

; TranslateMode=0 Un-translated message will be shown in English 

; TranslateMode=1 Un-translated message will be shown as #NoMessage = 

Message in English 

; TranslateMode=2 Un-translated message can be edited on fly 

 

Change TranslateMode to 2 and save the file. 

 

Now when you will run SpectraPro again, each time when an un-translated 

message will be find in the translation file, an edit windows will be shown: 
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Now you have the possibilities to translate on-fly the message. 

 

 

Don’t use this settings when too many message are not translated!  

The running of SpectraPro will be interrupted many times and you will be 

unable to use the software. Don’t forgot to set back the TranslateMode in the 

SpectraPro.ini file. 
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17. Route inspection code 
 

From Settings > Route inspection code menu you can activate the bellow window: 

 

In the table you can add up 

to 100 inspection codes. 

The inspection codes work 

only in conjunction with the 

Easy Viber Data Collector. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each time when a measurement is done, in the Instrument you have the 

possibilities to add an inspection code number. 

When the measurements will be down-loaded in the machine database, in the 

NotePad also the contents of the inspection code will be added. 

 

For each measurements\ you can add more than one inspection code. Read the 

Easy Viber User Manual for more details. 

 

In the Easy Viber Instrument the Inspection Codes can e mixed with some text 

message. Between Inspection code and text a separator is required. 

The separator can be: dot, dash or space. 

 

In the same message the same separator must be used. 
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Consider the Inspection Code for the above list: 

 
What user type in EV What SpectraPro send to Notepad 

1 status of machine 

-1-status of machine 

Ok status of machine 

4 and 2 

-4-and-2- 

.4.and.2. 

 

Bearing super-heated and Seal leaking 

 

4 and 70C 

.4.and 70C 

-4-and 70C 

 

Bearing super-heated and 70C 

Here is 3 

Here is.3. 

Here is-3- 

 

Here is Big noise 
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18. Using Notepad 
 

Notepad is available all the time when a plot is visible on the screen. 

 

The Notepad can be activated from the main toolbar menu: 

 

 

 

Also the Notepad can be activated from the popup menus of each plot (Show 

notepad command line). 

 

The Notepad date appears in accordance with the plot date. From a trend plot, 

the Notepad will appear with the cursor date. 

 

Because the Notepad contains appear in many Reports, a proper documentation 

done in the Notepad will assure a good report also.  

 

 
 

The Notepad must be use to document your diagnosis process. 

In the Notepad can be added: 

- Any plot form the screen 

- Any text using copy and paste 

- Any text or rtf external file 

- Any picture (including digital camera picture) 

 

The text can be formatted as in any standard text editor. 

The contents of a page can be saved in an rtf file type. 
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Notepad is page and machine oriented. Each page has its own date. Also the 

Notepad is synchronized with the plots. When a plot set focus and the Notepad is 

visible, the Notepad page will be automatically changed to the plot date and to 

the machine. 

 

If only the point or direction of the same machine is change in plot, the Notepad 

contents will be not affected. 

 

This means that all the time the Notepad has the active page on the right date 

and for the active machine. 

 

 

Is not need to save explicit the Notepad contents. Every time when the page is 

changed the previous contents is automatically saved in the database. 
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19. GraphView 

 

If the machine database is accessible in a network, is possible to present data in 

a simple, graphical way. 

 

A “black” protection key is required for each workstation. 

 

To create a GraphView data presentation follow the steps: 

 

1. In any computer from the network where the SpectraPro is 

installed, start SpectraPro and select (Database > Change) a 

database. 

2. Run external software Start > Programs > SpectraPro > GraphView 

Editor. 

3. The following windows will appear: 

 

 

4. Check one by one each Department to be moved in the graphic 

area. 

5. Move the icons in convenient location using the mouse. 

6. Click-right on Department icon and a popup menu will be shown: 

 

 

 

 

 

 

 From the above menu you can: 

� Re-name the Department 

� Adjust the icon size (small, medium or large) 

� Select a background color for icon. 

7. Click-right in the graphic area. The following popup menu will be 

shown: 
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8. You can do the followings: 

� Add a temporary grid to the graphic area 

� Select a background picture. The picture must have an 

approximate size to cover all the display area. Any type of 

picture file is accepted. 

� Add to the icons some position lines. 

� Preview the final graphic aspect of the page. 

 

9. Double-click on each Department icon. In the left side of the 

windows the machine list will be shown. Proceed as before and add 

machine. For each Department a new graphic page will be created. 

10. In each new page, double-click on each machine. In the left side of 

the windows the Points list will be shown. Add for each machine the 

points (Directions will be added also). For each machine a new 

graphic page will be created. 

11. In each page you can add a background picture. 

12. When you finish, just exit from GraphView Editor. The he pages will 

be automatically saved in the machine database. 

 

Now any computer from the network can be configured to show a graphic format 

of the database.  

 

To do these proceeds as follow: 

1. Install SpectraPro in the computer (and the latest Service 

Pack). Use a normal protection key to start SpectraPro. 

Select the desired database and close the SpectraPro. 

Remove the normal HASP protection key. 

2. Insert in any available USB hub a “black” protection key. 

3. Now when the SpectraPro start, instead to open the normal 

windows, will show a graphical view of the database. 

  

In GraphView mode, the user can change nothing; the database is read-only. 

 

If alarm limit is set, also the icons will be colored according with alarm level in the 

machine tree. 

 

Clicking on a Department icon, the Machine page will be shown. 

Clicking on a Machine icon, a Point page will be shown. 

Clicking on Point icon a special kind of Quick View will be shown. 

 

 

 

 

 

 

This is what the user can see in GraphView mode: 

 



SpectraPro
©©©©
 User Manual 

 

 
112 

 

 

On 

Department 

level 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On Machine 

level 
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On Point 

level 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The number of workstations to show GraphView is unlimited. 

Contact VMI AB to obtain GraphView Protection Key. 
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20. SQL Server Database Manager 
 
If you create database in MSDE database Server, you are not able to make 

periodically database backup or to delete unused database. 

 

For this reason a simple Database Manager is included in each SpectraPro 

package. 

 

Run Start > Programs > SpectraPro > MSDE Database manager. 

 

 

If you have an older SpectraPro installation, the application will not appear as 

above. In this case, locate the SpectraPro installation directory (in a default 

installation is C:\Program Files\SpectraPro and run manually DBManager.exe. 

 

 

In the left windows all the SpectraPro database are shown. 

In the right side are presented some statistics regarding the selected database. 

 

 

This software is provided “as is it”. No any guarantee is provided using this 

software. Microsoft can provide professional tools for SQL Server maintenance! 

 

 

 

You can do the following actions: 
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- Register the selected database into SpectraPro.  

- Remove the selected database from the SpectraPro registration list 

- Erase the selected database files. All the information’s will be lost! No 

recovery is possible! 

- Create a protection backup. To do this press Backup button: 

 

Select a directory where 

the backup copy of the 

database will be created 

and press Backup 

button. 

 

 

 

 

 

 

- Restore a previous backup of the database. Use Restore command: 

 

 

From the list select a file to be restored (normally the latest backup). Press 

Restore button. 

 

 

If restore process occur, any information since the last backup will be lost! 

 

 

- Update the selected database. This action will optimize the size of the 

database and will re-index the tables. This action will seep-up the access 

to the database items. 

- Detach command. This action will detach the database from the MSDE 

server. After detaching, the database files can be copied and moved in 

another computer. 

- Connect command. A detached database can be connected (attached) to 

another MSDE database.   

 


